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Tuyªn bè b¶n quyÒn: 

Tµi liÖu nµy thuéc lo¹i s¸ch gi¸o tr×nh, 

cho nªn c¸c nguån th«ng tin cã thÓ ®−îc 

phÐp dïng nguyªn b¶n hoÆc trÝch dïng cho 

c¸c môc ®Ých vÒ ®µo t¹o vµ tham kh¶o. Mäi 

môc ®Ých kh¸c cã ý ®å lÖch l¹c hoÆc sö 

dông víi môc ®Ých kinh doanh thiÕu lµnh 

m¹nh sÏ bÞ nghiªm cÊm. 

Tæng côc D¹y nghÒ sÏ lµm mäi c¸ch 

®Ó b¶o vÖ b¶n quyÒn cña m×nh. 

Tæng côc D¹y nghÒ c¸m ¬n vµ hoan 

nghªnh c¸c th«ng tin gióp cho viÖc tu söa 

vµ hoµn thiÖn tèt h¬n tµi liÖu nµy. 

§Þa chØ liªn hÖ: 

Tæng côc D¹y nghÒ 

37B NguyÔn BØnh Khiªm - Hµ Néi  
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Lêi Nãi ®Çu 

Gi¸o tr×nh AutoCAD ®−îc x©y dùng vµ biªn so¹n trªn c¬ së ch−¬ng tr×nh khung 
®µo t¹o nghÒ C¾t gät kim lo¹i ®' ®−îc Gi¸m ®èc Dù ¸n Gi¸o dôc kü thuËt vµ D¹y 
nghÒ quèc gia phª duyÖt dùa vµo n¨ng lùc thùc hiÖn cña ng−êi kü thuËt viªn tr×nh ®é 
lµnh nghÒ. 

Trªn c¬ së ph©n tÝch nghÒ vµ ph©n tÝch c«ng viÖc (theo ph−¬ng ph¸p DACUM) 
cña c¸c c¸n bé, kü thuËt viªn cã nhiÒu kinh nghiÖm, ®ang trùc tiÕp s¶n xuÊt cïng víi 
c¸c chuyªn gia ®' tæ chøc nhiÒu ho¹t ®éng héi th¶o, lÊy ý kiÕn, v.v..., ®ång thêi c¨n 
cø vµo tiªu chuÈn kiÕn thøc, kü n¨ng cña nghÒ ®Ó biªn so¹n. Ban gi¸o tr×nh 
AutoCAD do tËp thÓ c¸n bé, gi¶ng viªn, kü s− cña tr−êng Cao ®¼ng C«ng nghiÖp 
HuÕ vµ c¸c kü thuËt viªn giµu kinh nghiÖm biªn so¹n. Ngoµi ra cã sù ®ãng gãp tÝch 
cùc cña c¸c gi¶ng viªn Tr−êng §¹i häc B¸ch khoa Hµ Néi vµ c¸n bé kü thuËt thuéc 
C«ng ty C¬ khÝ Phó Xu©n, C«ng ty ¤t« Thèng nhÊt, C«ng ty S¶n xuÊt vËt liÖu x©y 
dùng Long Thä. 

Ban biªn so¹n xin ch©n thµnh c¶m ¬n Tr−êng §¹i häc B¸ch khoa Hµ Néi, C«ng 
ty C¬ khÝ Phó Xu©n, C«ng ty ¤t« Thèng nhÊt, C«ng ty S¶n xuÊt vËt liÖu x©y dùng 
Long Thä, Ban Qu¶n lý Dù ¸n GDKT&DN vµ c¸c chuyªn gia cña Dù ¸n ®' céng 
t¸c, t¹o ®iÒu kiÖn gióp ®ì trong viÖc biªn so¹n gi¸o tr×nh. Trong qu¸ tr×nh thùc hiÖn, 
ban biªn so¹n ®' nhËn ®−îc nhiÒu ý kiÕn ®ãng gãp th¼ng th¾n, khoa häc vµ tr¸ch 
nhiÖm cña nhiÒu chuyªn gia, c«ng nh©n bËc cao trong lÜnh vùc nghÒ C¾t gät kim 
lo¹i. Song do ®iÒu kiÖn vÒ thêi gian, mÆt kh¸c ®©y lµ lÇn ®Çu tiªn biªn so¹n gi¸o 
tr×nh dùa trªn n¨ng lùc thùc hiÖn, nªn kh«ng tr¸nh khái nh÷ng thiÕu sãt nhÊt ®Þnh. 
RÊt mong nhËn ®−îc nh÷ng ý kiÕn ®ãng gãp ®Ó gi¸o tr×nh AutoCAD ®−îc hoµn thiÖn 
h¬n, ®¸p øng ®−îc yªu cÇu cña thùc tÕ s¶n xuÊt cña c¸c doanh nghiÖp hiÖn t¹i vµ 
trong t−¬ng lai. 

Gi¸o tr×nh AutoCAD ®−îc biªn so¹n theo c¸c nguyªn t¾c: TÝnh ®Þnh h−íng thÞ 
tr−êng lao ®éng; TÝnh hÖ thèng vµ khoa häc; TÝnh æn ®Þnh vµ linh ho¹t; H−íng tíi 
liªn th«ng, chuÈn ®µo t¹o nghÒ khu vùc vµ thÕ giíi; TÝnh hiÖn ®¹i vµ s¸t thùc víi s¶n 
xuÊt. 

Gi¸o tr×nh AutoCAD nghÒ C¾t gät kim lo¹i cÊp tr×nh ®é Lµnh nghÒ ®' ®−îc Héi 
®ång thÈm ®Þnh Quèc gia nghiÖm thu vµ nhÊt trÝ ®−a vµo sö dông vµ ®−îc dïng lµm 
gi¸o tr×nh cho häc viªn trong c¸c khãa ®µo t¹o ng¾n h¹n hoÆc cho c«ng nh©n kü 
thuËt, c¸c nhµ qu¶n lý vµ ng−êi sö dông nh©n lùc tham kh¶o. 

§©y lµ tµi liÖu thö nghiÖm sÏ ®−îc hoµn chØnh ®Ó trë thµnh gi¸o tr×nh chÝnh thøc 
trong hÖ thèng d¹y nghÒ. 

Ngµy 15 th¸ng 4 n¨m 2008 
HiÖu tr−ëng 

Bïi Quang ChuyÖn 
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Giíi thiÖu 

PhÇn mÒm AutoCAD cña h'ng AutoDESK lµ mét trong nh÷ng phÇn mÒm phæ 
biÕn, sö dông dÔ dµng mµ ®−îc nhiÒu ng−êi sö dông nhÊt trong c¸c phÇn mÒm rî 
gióp thiÕt kÕ CAD, t¹o c¸c b¶n vÏ kü thuËt nhanh vµ ®Ñp. Víi sù trî gióp cña m¸y 
tÝnh kh«ng nh÷ng t¹o b¶n vÏ kü thuËt mµ cßn ph©n tÝch b¶n vÏ, t¹o h×nh, biÓu diÔn 
vËt thÓ. 

PhÇn mÒm AutoCAD lµ c«ng cô hç trî cho c¸n bé kü thuËt, kü thuËt viªn, c«ng 
nh©n kü thuËt... hoµn thµnh c¸c b¶n vÏ thiÕt kÕ cña m×nh mét c¸ch nhanh chãng vµ 
chÝnh x¸c h¬n. M«n häc vÏ thiÕt kÕ b»ng m¸y tÝnh (sö dông AutoCAD) ®' trë thµnh 
m«n häc chÝnh kho¸ cña c¸c tr−êng ®¹i häc, cao ®¼ng, trung cÊp vµ d¹y nghÒ. 

S¸ch ®−îc viÕt gän víi nh÷ng phÇn mµ häc sinh cÇn cã thÓ hoµn thµnh ®−îc b¶n 
vÏ kü thuËt.  
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Giíi thiÖu vÒ m« ®un 

I. VÞ trÝ, ý nghÜa, vai trß m« ®un: 

M« ®un vÏ AutoCAD lµ mét m« ®un chuyªn ngµnh, lµ mét phÇn kiÕn thøc 
kh«ng thÓ thiÕu ®−îc trong viÖc ®µo t¹o h×nh thµnh tay nghÒ 1 thî c¾t gät kim lo¹i. 

Tr−íc khi häc m« ®un vÏ AutoCAD häc sinh ph¶i ®−îc häc qua c¸c m«n häc: vÏ 
kü thuËt c¬ b¶n, Tin häc c¨n b¶n, to¸n líp 10 

M« ®un vÏ AutoCAD gióp cho häc sinh hoµn thµnh b¶n vÏ nhanh chãng, thiÕt 
kÕ c¸c s¶n phÈm C¬ khÝ, gióp tÝnh to¸n khai triÓn c¸c s¶n phÈm gß hµn, tÝnh chu vi, 
diÖn tÝch cña ®−êng, mÆt, khèi...   

II. Môc tiªu cña m« ®un: 

Häc xong m« ®un nµy häc viªn sÏ: 

- Thùc hiÖn ®−îc c¸c lÖnh vÏ trªn 2D. 

- Hoµn thµnh ®−îc b¶n vÏ kü thuËt vµ in ®−îc b¶n vÏ ra giÊy. 

- Sö dông ®−îc c¸c øng dông trong tÝnh to¸n chu vi cña mét ®−êng, diÖn tÝch cña 
mét bÒ mÆt, thÓ tÝch cña mét khèi vµ vÏ khai triÓn c¸c biªn d¹ng.  

III. Môc tiªu thùc hiÖn cña m« ®un: 

Häc xong m« ®un nµy häc viªn cã kh¶ n¨ng: 

- Sö dông ®−îc c¸c lÖnh, biÕt ®−îc c¸c yªu cÇu cña lÖnh t¹i dßng nh¾c lÖnh. 

- Hoµn thµnh ®−îc b¶n vÏ kü thuËt vµ hiÖu chØnh ®−îc b¶n vÏ, in ®−îc b¶n vÏ 
ra giÊy.  

- Sö dông ®−îc c¸c øng dông trong tÝnh to¸n chu vi cña mét ®−êng, diÖn tÝch cña 
mét bÒ mÆt, thÓ tÝch cña mét khèi vµ vÏ khai triÓn c¸c biªn d¹ng.  

IV. Néi dung chÝnh cña m« ®un: 

KiÕn thøc: 

Bµi 1. Sö dông ch−¬ng tr×nh vÏ AutoCAD  

1. §Æc ®iÓm c¸c phÇn mÒm CAD  

2. Giíi thiÖu AutoCAD  

3. Khëi ®éng AutoCAD 2000  

4. CÊu tróc mµn h×nh AutoCAD 2000  
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Bµi 2. ThiÕt lËp b¶n vÏ n»m trong vïng vÏ  

1. Giíi thiÖu  

2. T¹o b¶n vÏ míi  

3. Ghi b¶n vÏ thµnh file  

4. Më file b¶n vÏ cã s½n  

5. XuÊt d÷ liÖu sang d¹ng kh¸c   

6. §ãng b¶n vÏ  

7. KÕt thóc lµm viÖc víi AutoCAD  

8. BiÕn save time  

9. Giíi h¹n b¶n vÏ  

10. LÖnh Ortho  

Bµi 3. Sö dông c¸c lÖnh vÏ c¬ b¶n vµ nhËp ®iÓm chÝnh x¸c 

1. HÖ to¹ ®é sö dông trong AutoCAD  

2. C¸c ph−¬ng ph¸p nhËp to¹ ®é ®iÓm  

3. C¸c lÖnh vÏ c¬ b¶n  

3.1. VÏ ®−êng trßn  

3.2. VÏ cung trßn (lÖnh Arc)  

4. VÏ ®a tuyÕn (lÖnh Pline)  

5. VÏ h×nh ®a gi¸c ®Òu  

6. VÏ h×nh ch÷ nhËt                         

7. VÏ ®−êng Elip                   

8.  VÏ ®−êng cong Spline                   

9.  VÝ dô sö dông c¸c lÖnh vÏ t¹o h×nh h×nh häc   

Bµi 4. C¸c ph−¬ng thøc truy b¾t ®iÓm 

1. VÏ ®o¹n th¼ng (lÖnh Line) vµ c¸c ph−¬ng ph¸p nhËp ®iÓm  

2. VÏ ®−êng trßn (lÖnh Circle) sö dông c¸c ph−¬ng ph¸p nhËp ®iÓm  

3. C¸c ph−¬ng thøc truy b¾t ®iÓm cña ®èi t−îng (Object Snap)  

4. C¸c vÝ dô sö dông ph−¬ng thøc b¾t ®iÓm  

5. G¸n chÕ ®é truy b¾t th−êng tró (lÖnh Osnap)  

Bµi tËp  

Bµi 5. Lùa chän ®èi t−îng, hiÖu chØnh ®èi t−îng 

1. Xo¸ vµ phôc håi c¸c ®èi t−îng bÞ xo¸  
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2. Huû bá lÖnh ®· thùc hiÖn  

3. C¸c ph−¬ng ph¸p lùa chän ®èi t−îng  

4. XÐn mét phÇn ®èi t−îng n»m gi÷a hai ®èi t−îng giao  

5. XÐn mét phÇn ®èi t−îng n»m gi÷a hai ®iÓm chän  

6. VÏ nèi tiÕp hai ®èi t−îng bëi cung trßn (LÖnh Fillet)  

7. V¸t mÐp c¹nh (LÖnh Chamfer)  

8. T¹o c¸c ®èi t−îng song song (LÖnh Offset)  

9. KÐo dµi ®èi t−îng (LÖnh Extend)  

10. Bµi tËp                    

Bµi 6. C¸c lÖnh vÏ nhanh 

1. PhÐp dêi h×nh  

2. PhÐp ®èi xøng qua trôc  

3. Quay chung quanh mét ®iÓm  

4. PhÐp biÕn ®æi tû lÖ  

5. KÐo gi·n ®èi t−îng  

6. Sao chÐp h×nh 

7. Sao chÐp d·y  

8. Bµi tËp 

Bµi 7.  Qu¶n lý ®èi t−îng trong b¶n vÏ (Líp- mµu vµ ®−êng nÐt) 

1. T¹o vµ hiÖu chØnh líp         
2. T¹o líp míi  

3. G¸n vµ thay ®æi mµu cho líp  

4. G¸n d¹ng ®−êng cho líp  

5. G¸n chiÒu réng nÐt in (line weight)  

6. G¸n líp hiÖn hµnh (current)  

7. T¾t më líp (on/off)  

8. §ãng vµ lµm tan b¨ng cña mét líp cho tÊt c¶ khung nh×n (Freeze/thaw)  

9. Kho¸ vµ më kho¸ cho líp (lock/unlock)  

Bµi 8  Ghi vµ hiÖu chØnh v¨n b¶n 

1. T¹o kiÓu ch÷ (text style)         

2. Ph−¬ng ph¸p nhËp dÊu tiÕng viÖt theo font VNI font  

3. NhËp ®o¹n v¨n b¶n vµo b¶n vÏ (lÖnh Mtext)  

4. HiÖu chØnh v¨n b¶n Mtext b»ng lÖnh Mtprop  
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Bµi 9. H×nh c¾t vµ mÆt c¾t - vÏ ký hiÖu vËt liÖu 

1. VÏ mÆt c¾t b»ng lÖnh Bhatch  

2. X¸c ®Þnh ®−êng biªn mÆt c¾t (Boundary)  

3. HiÖu chØnh mÆt c¾t (Hatchedit)  

4. Bµi tËp  

Bµi 10.  Ghi vµ hiÖu chØnh kÝch th−íc 

1. C¸c thµnh phÇn kÝch th−íc  

2. Ghi kÝch th−íc th¼ng  

3. Ghi kÝch th−íc cung vµ ®−êng trßn  

4. Ghi To¹ ®é ®iÓm 

5. Bµi tËp  

Kü n¨ng: 

- Nhí c¸c tõ lÖnh.  

- Thùc hiÖn ®−îc c¸c phÝm t¾c cña tõ lÖnh 

- N¾m ®−îc c¸c yªu cÇu cña lÖnh t¹i dßng nh¾c cña lÖnh khi thùc hiÖn 

- Lùa chän lÖnh vÏ phï hîp cho tõng tr−êng hîp khi vÏ c¸c h×nh kh¸c nhau. 

- Sö dông thµnh th¹o c¸c ph−¬ng tøc truy b¾t ®iÓm 

- Lùa chän ®−îc c¸c chÕ ®é vÏ trong thanh c«ng cô vÏ options   

V. C¸c ho¹t ®éng häc tËp chÝnh trong m« ®un 

Ho¹t ®éng 1: Häc tËp trªn líp vÒ 

- C¸ch vµo m«i tr−êng lµm viÖc cña Autocad, cÊu tróc ®å ho¹ cña mµn h×nh 
Autocad, c¸c chøc n¨ng trªn c¸c thanh c«ng cô.   

- T¹o, l−u vµ më b¶n vÏ, t¹o vïng vÏ vµ giíi h¹n vïng vÏ. 

- C¸c c¸ch nhËp ®é cña ®iÓm. 

- C¸c lÖnh vÏ c¬ b¶n, c¸c lÖnh hiÖu chØnh vµ c¸c lÖnh vÏ nhanh. 

- T¹o líp vµ t¹o nÐt vÏ, mµu cho líp. 

- Ghi v¨n b¶n vµ hiÖu chØnh v¨n b¶n. 

- Ghi kÝch th−íc vµ hiÖu chØnh kÝch th−íc. 

- Lµm c¸c bµi tËp vÝ dô. 

Ho¹t ®éng 2: Ho¹t ®éng theo nhãm 
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Ho¹t ®éng 3: Thùc hµnh trªn m¸y 

- Khëi ®éng m¸y. 

- X¸c ®Þnh c¸c thanh c«ng cô. 

- T¹o, l−u vµ më b¶n vÏ, t¹o vïng vÏ vµ giíi h¹n vïng vÏ. 

- C¸c c¸ch nhËp ®é cña ®iÓm. 

- C¸c lÖnh vÏ c¬ b¶n, c¸c lÖnh hiÖu chØnh vµ c¸c lÖnh vÏ nhanh. 

- T¹o líp vµ t¹o nÐt vÏ, mµu cho líp. 

- Ghi v¨n b¶n vµ hiÖu chØnh v¨n b¶n. 

- Ghi kÝch th−íc vµ hiÖu chØnh kÝch th−íc. 

- Lµm c¸c bµi tËp vÝ dô. 

Ho¹t  ®éng 4: Thùc hµnh vÏ trªn m¸y lµm c¸c bµi tËp n©ng cao nh»m n©ng cao 
kü n¨ng b»ng c¸c lÖnh vÏ nhanh. 

VI. Yªu cÇu vÒ ®¸nh gi¸ hoµn thµnh m« ®un  

KiÕn thøc:  

- Khëi ®éng m¸y, c¸c chøc n¨ng trªn c¸c thanh c«ng cô  

- HÖ to¹ ®é, ph−¬ng thøc nhËp to¹ ®é vµ ph−¬ng thøc truy b¾t ®iÓm.  

- C¸c lÖnh vÏ c¬ b¶n vµ c¸c lÖnh vÏ nhanh. 

- C¸c lÖnh hiÖu chØnh. 

- C¸c lÖnh vÏ vµ hiÖu chØnh mÆt c¾t, kÝch th−íc, ®−êng nÐt, ch÷ viÕt. 

Kü n¨ng: 

- Thµnh lËp b¶n vÏ 

- X¸c ®Þnh ph−¬ng ph¸p vÏ, c¸ch nhËp to¹ ®é vµ c¸c ph−¬ng thøc truy b¾t ®iÓm. 

- X¸c ®Þnh lÖnh vÏ phï hîp cho tõng tr−êng hîp vÏ. 

- Sö dông ®−îc c¸c phÝm gâ t¾t cña lÖnh khi vÏ. 

- Sö dông thµnh th¹o c¸c lÖnh hiÖu chØnh ®èi t−îng. 

- T¹o h×nh c¾t, mÆt c¾t, ch÷ viÕt, kÝch th−íc theo ®óng tû lÖ trªn b¶n vÏ. 

C«ng cô ®¸nh gi¸: 

- HÖ thèng c©u hái tr¾c nghiÖm vÒ c¸c lÖnh vÏ. 

- HÖ thèng c¸c bµi tËp tÝnh to¸n to¹ ®é ®iÓm trªn b¶n vÏ theo to¹ ®é “§Ò c¸c” 
tuyÖt ®èi, t−¬ng ®èi vµ to¹ ®é “Cùc” tuyÖt ®èi, t−¬ng ®èi. 
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- HÖ thèng c¸c bµi tËp thùc hµnh vÏ c¸c h×nh c¬ b¶n trªn m¸y. 

- HÖ thèng c¸c bµi tËp thùc hµnh vÏ c¸c h×nh chiÕu trªn m¸y. 

- HÖ thèng c¸c bµi tËp thùc hµnh vÏ hoµn thiÖn b¶n vÏ kü thuËt 

Ph−¬ng ph¸p ®¸nh gi¸: 

- Tr¾c nghiÖm: lý thuyÕt c¸c c©u lÖnh. 

- KiÓm tra vÏ h×nh trªn m¸y ®¹t bao nhiªu phÇn tr¨m h×nh vÏ yªu cÇu trong thêi 
gian quy ®Þnh. 

� B¶n vÏ ®Ñp (ph©n bè mµu s¾c).  

� B¶n vÏ ®óng yªu cÇu kü thuËt. 
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Bµi 1 

Sö dông ch−¬ng tr×nh vÏ AutoCAD  

M· bµi: M§ CG1 13 01 

I. Giíi thiÖu: 

- Bµi häc nµy gióp cho häc sinh n¾m s¬ l−îc c¸c ®Æc ®iÓm cña phÇn mÒm, lÞch 
sö ph¸t triÓn phÇn mÒm.  

- C¸ch vµo m«i tr−êng lµm viÖc AutoCAD, biÕt ®−îc c¸c chøc n¨ng cña c¸c 
thanh c«ng cô, biÓu t−îng, c¸c danh môc trªn c¸c thanh c«ng cô. 

II. Môc tiªu thùc hiÖn: 

- X¸c ®Þnh ®−îc c¸c ®Æc ®iÓm cña phÇn mÒm AutoCAD . 

- Vµo ®−îc m«i tr−êng lµm viÖc AutoCAD . 

- X¸c ®Þnh ®−îc c¸c chøc n¨ng trªn mµn h×nh ®å ho¹. 

III. Néi dung chÝnh: 

1. §Æc ®iÓm c¸c phÇn mÒm AutoCAD. 

2. Giíi thiÖu AutoCAD. 

3. Khëi ®éng AutoCAD 2000. 

4. CÊu tróc mµn h×nh AutoCAD 2000. 

IV.  C¸c h×nh thøc häc tËp: 

- Häc trªn líp vÒ ®Æc ®iÓm, giíi thiÖu vÒ phÇn mÒm, c¸ch khëi ®éng phÇn mÒm, 
cÊu tróc mµn h×nh ®å ho¹. 

- Gi¸o viªn dïng m¸y chiÕu Projector chiÕu lªn b¶ng h−íng dÉn c¸ch khëi ®éng 
m¸y, tr×nh bµy vµ gi¶i thÝch c¸c chøc n¨ng cña tõng danh môc trªn mµn h×nh ®å ho¹. 

1. §Æc ®iÓm c¸c phÇn mÒm AutoCAD 

- CAD lµ ch÷ viÕt t¾c cña computer-Aided Design hoÆc Computer-Aided 
Drafting (vÏ vµ thiÕt kÕ víi sù trî gióp cña m¸y tÝnh) 

- Sö dông c¸c phÇn mÒm AutoCAD cã thÓ vÏ thiÕt kÕ c¸c b¶n vÏ 2 chiÒu (2D) 
thiÕt kÕ m« h×nh 3 chiÒu (3D) tÝnh to¸n thiÕt kÕ b»ng phÇn mÒm phÇn tö h÷u h¹n 
(FEA – chøc n¨ng Analysis) 
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- PhÇn mÒm CAD cã 3 ®Æc ®iÓm næi bËt sau: 

� ChÝnh x¸c 

� N¨ng suÊt cao nhê c¸c lÖnh sao chÐp 

� DÔ dµng trao ®æi d÷ liÖu víi c¸c phÇn mÒm kh¸c 

2. Giíi thiÖu AutoCAD 

- PhÇn mÒm cña h·ng AutoDesk dïng ®Ó vÏ c¸c b¶n vÏ kü thuËt trong c¸c 
ngµnh: X©y dùng, c¬ khÝ, KiÕn tróc, ®iÖn, b¶n ®å...  

- B¶n vÏ nµo thùc hiÖn ®−îc b»ng compa, th−íc kÎ vµ bót ch× ®Òu ®−îc vÏ thiÕt 
kÕ b»ng phÇn mÒm AutoCAD. 

- MÒm AutoCAD ®−îc giíi thiÖu lÇn ®Çu tiªn vµo th¸ng 11-1982 t¹i héi chî 
COMDEX ®Õn th¸ng 12 – 1982 c«ng bè phiªn b¶n ®Çu tiªn (Release 1). 

- Th¸ng 03-1999 Phiªn b¶n AutoCAD ®Çu tiªn ra ®êi vµ ch¹y trªn m«i tr−êng 
Windows 98, NT  

3. Khëi ®éng AutoCAD 2000 

- Sau khi cµi ®Æt AutoCAD 2000 ®Ó khëi ®éng ta chän biÓu 
t−îng (H×nh 13.1.1) vµ nhÊp hai lÇn phÝm tr¸i chuét.  

- Sau ®ã xuÊt hiÖn hép tho¹i Startup (H×nh 13.1.2). råi chän 
vµo « start 

- From Scratch (H×nh 13.1.3) 

 

 

 

 

 

 

 

 

 

  

4. CÊu tróc mµn h×nh AutoCAD 2000 

- Drawing (Graphics) Area: Vïng ®å ho¹ lµ vïng thÓ hiÖn b¶n vÏ, mµu mµn 
h×nh ®−îc ®Þnh bëi hép tho¹i Options (H×nh 13. 1.4) 

  

(H×nh 13.1.2) (H×nh 13.1.3) 

H×nh 13.1.1. 

AutoCAD2000 
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- Crosshairs: Hai sîi tãc theo ph−¬ng trôc X vµ trôc Y giao nhau t¹i 1 ®iÓm. 

- Curcor: Con ch¹y lµ mét « h×nh vu«ng, ®é lín con ch¹y ®−îc quy ®Þnh bëi biÕn 

- Néi dung chÝnh: 

- CÊu tróc mµn h×nh AutoCAD 2000 
  

 
H×nh 13.1.4 

 
- Command Window vµ command line 

+ Cöa sæ lÖnh (Command Window) bao gåm nhiÒu dßng lÖnh (Commandline)  

+ Sè dßng lÖnh trong cöa sæ lÖnh ®−îc mÆc ®Þnh lµ 3 dßng (H×nh 13. 1.5) 

+ §©y lµ n¬i ta nhËp lÖnh vµo vµ hiÓn thÞ c¸c dßng nh¾c lÖnh cña AutoCAD.  

 
H×nh 13.1.5 

Draw  toolbar 

Modify toolbar 

User   Coordinate 

System (UCS) Icon 

Crosshairs 
Cursor 

Objects  

Properties 

Standard 

Toolbar 

Scroll 
Toolbar 

Command line 
Status bar 

   Command line 
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- Menu bar: 

+ Danh môc chÝnh, n»m phÝa trªn vïng ®å ho¹  
+ AutoCAD 2000 cã 12 danh môc, mçi danh môc chøa mét nhãm lÖnh  
+ C¸c danh môc AutoCAD 2000 bao gåm: File, Edit, View, Insert, Format, 

Tools, Draw, Dimension, Modify, Express, Window, vµ Help. (H×nh 13.1.6).  

 
H×nh 13.1.6 

- Pull-down menu 

+ Danh môc lÖnh (Danh môc kÐo xuèng) Khi ta chän mét danh môc trªn mçi 
danh môc chÝnh sÏ xuÊt hiÖn mét nhãm lÖnh.  (H×nh 13.1.7). 

+ T¹i c¸c lÖnh nµy ta cã thÓ gäi c¸c lÖnh thùc hiÖn. 
+ NÕu lÖnh nµo cã dÊu > th× sÏ xuÊt hiÖn mét danh s¸ch lùa chän lÖnh hoÆc danh 

s¸ch c¸c lÖnh con liªn quan.  

  
H×nh 13.1.7 

- Toolbar 

+ Thanh c«ng cô trong AutoCAD 2000 cã 24 toolbars, mçi lÖnh cã mét biÓu 
t−îng lÖnh lÖnh trong toolbars. 

+ Khi ®−a con trá ®Õn c¸c thanh toolbars vµ nhÊn phÝm ph¶i chuét sÏ xuÊt hiÖn 
shortcut menu (H×nh 13. 1.7) 
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Bµi 2 

 ThiÕt lËp b¶n vÏ n»m trong vïng vÏ 

M· bµi: M§ CG1 27 02 

I. Giíi thiÖu: 

- Bµi häc nµy gióp cho häc sinh n¾m ®−îc c¸ch t¹o b¶n vÏ míi.  

- Giíi h¹n vïng vÏ vµ c¸c chÕ ®é b¶n vÏ. 

II. Môc tiªu thùc hiÖn: 

- T¹o ®−îc c¸c b¶n vÏ míi. 

- Giíi h¹n ®−îc vïng vÏ. 

- X¸c lËp ®−îc c¸c chÕ ®é vÏ. 

III. Néi dung chÝnh: 

1. Giíi thiÖu phÇn mÒm AutoCAD 

2. T¹o b¶n vÏ míi 

3. Ghi b¶n vÏ thµnh file 

4. Më file b¶n vÏ cã s½n 

5. XuÊt d÷ liÖu sang d¹ng kh¸c  

6. §ãng b¶n vÏ 

7. KÕt thóc lµm viÖc víi AutoCAD 

8. BiÕn save time 

9. Giíi h¹n b¶n vÏ 

10 LÖnh Ortho 

IV. C¸c h×nh thøc häc tËp: 

- Häc trªn líp vÒ t¹o b¶n vÏ míi 

- Më vµ ghi b¶n vÏ thµnh file. 

- Giíi h¹n b¶n vÏ (vïng vÏ). 

- Gi¸o viªn dïng m¸y chiÕu Projector chiÕu lªn b¶ng h−íng dÉn c¸ch t¹o b¶n vÏ, 
tr×nh bµy vµ gi¶i thÝch vïng thÓ hiÖn b¶n vÏ, c¸ch më vµ ghi b¶n vÏ thµnh file. 
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1. Giíi thiÖu 

- C¸c lÖnh vÒ file trong AutoCAD 2000 n»m trong file menu (H×nh 13. 2.1) vµ 
trªn thanh c«ng cô standard toolbar d−íi d¹ng c¸c biÓu t−îng. 

- Tªn file cña AutoCAD 2000 t−¬ng tù tªn file c¸c øng dông cña Windows 95, 
98 vµ Windows NT cã tèi ®a 256 ký tù. 

- File b¶n vÏ AutoCad cã phÇn më réng lµ .DWG (c¸c b¶n vÏ mÉu cã phÇn më 
réng lµ .DWT). 

- Tªn file cã thÓ ch÷ in hoa, ch÷ th−êng 

 
H×nh 13.2.1 

2. T¹o b¶n vÏ míi 

- LÖnh: New 

- NhËp lÖnh: 3 c¸ch 

+ Trªn menu chÝnh ta chän file → chän New 

+ T¹i dßng command: ta nhËp New ↵ 

+ Trªn thanh Standard toolbar ta nhÊn chuét tr¸i vµo biÓu t−îng   

- Khi thùc hiÖn lÖnh New trªn mµn h×nh xuÊt hiÖn hép tho¹i Create New 
Drawing (H×nh 13. 2.2) cho phÐp t¹o c¸c file b¶n vÏ míi. Hép tho¹i nµy gåm 4 trang: 
Open Drawing, Start from scratch, Use a template, Use a Wizard. 
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H×nh 13. 2.2 

2.1. Trang Start from Scratch 

- Trªn trang Start from scratch ta chän Metric vµ nhÊn ok (hoÆc Enter) th× ta ®· 
chän giíi h¹n b¶n vÏ lµ 420,297 vµ ®¬n vÞ vÏ theo hÖ mÐt vµ ®−îc ®o theo ®¬n vÞ lµ 
millimeter. 

- NÕu chän English th× ®¬n vÞ lµ inch vµ giíi h¹n vÏ lµ 12,9 

- NÕu chän Metric th× ta ph¶i giíi h¹n b¶n vÏ trªn khæ giÊy A3 (420,297) 

2.2. Trang Use a template 

- Trang Use a template cho phÐp ta chän c¸c b¶n vÏ mÉu cã s½n trong AutoCAD 
víi phÇn më réng .DWT (H×nh 13. 2.3) 

- Lùa chän c¸c b¶n vÏ theo mÉu ANSI (tiªu chuÈn Mü), ISO (tiªu chuÈn quèc tÕ), 
DIN (tiªu chuÈn §øc), JIS (tiªu chuÈn NhËt) hoÆc c¸c b¶n vÏ ta tù t¹o theo TCVN. 

    

   
   H×nh 13. 2.3                                              H×nh 13. 2.3 
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3. Ghi b¶n vÏ thµnh file 

3.1. LÖnh Save 

- LÖnh Save,: Dïng ®Ó ghi b¶n vÏ hiÖn hµnh thµnh mét file. 

- NhËp lÖnh: 3 c¸ch 

+ Trªn menu chÝnh ta chän file → chän Save 

+ T¹i dßng command: ta nhËp Save ↵ 

+ Trªn thanh Standard toolbar ta nhÊn chuét tr¸i vµo biÓu t−îng 

- Khi nhËp lÖnh xuÊt hiÖn hép tho¹i Save drawing as (H×nh 13. 2.5). Ta nhËp tªn 
file vµo « so¹n th¶o File Name, nhÊn nót Save 

- Ta cã thÓ ®Þnh kho¶ng thêi gian tù ®éng ghi b¶n vÏ b»ng biÕn Savetime 

 
H×nh 13. 2.5 

3.2. LÖnh Save as 

- LÖnh Saveas: dïng ®Ó save b¶n vÏ hiÖn hµnh thµnh mét tªn kh¸c. C¸c b−íc 
thùc hiÖn hoµn toµn gièng lÖnh Save 

- NhËp lÖnh:  2 c¸ch 

+ Trªn menu chÝnh ta chän file → chän Saveas 

+ T¹i dßng command: ta nhËp Saveas ↵ 

4. Më file b¶n vÏ cã s½n 

- LÖnh Open,: Dïng ®Ó më mét file b¶n vÏ. 

- NhËp lÖnh: 3 c¸ch 

+ Trªn menu chÝnh ta chän file → chän Open 

+ T¹i dßng command: ta nhËp Open ↵ 
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+ Trªn thanh Standard toolbar ta nhÊn chuét tr¸i vµo biÓu t−îng 

- Khi thùc hiÖn lÖnh Open sÏ xuÊt hiÖn hép tho¹i Select file (H×nh 13. 2.5) 

- Trªn hép tho¹i nµy ta chän file b¶n vÏ cÇn më t¹i b¶ng liÖt kª tªn file vµ sau ®ã 
chän Open. 

- LÖnh Open cã thÓ më c¸c file cã phÇn më réng .DWG, .DWT, DXF. 
     

 
H×nh 13. 2.5 

5. XuÊt d÷ liÖu sang d¹ng kh¸c  

- LÖnh Export: cho phÐp xuÊt d÷ liÖu b¶n vÏ víi c¸c phÇn më réng kh¸c nhau. 
Nhê vµo lÖnh nµy mÒm kh¸c (H×nh 13. 2.6) 

- NhËp lÖnh: 2 c¸ch 

+ Trªn menu chÝnh ta chän file → chän Export 

+ T¹i dßng command: ta nhËp export ↵ 
  

 
H×nh 13. 2.6 
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6. §ãng b¶n vÏ 

- LÖnh close: Dïng ®Ó ®ãng b¶n vÏ  

- NhËp lÖnh: 2 c¸ch 

+ Trªn menu chÝnh ta chän file → chän Close 

+ T¹i dßng command: ta nhËp close ↵ 

7. KÕt thóc lµm viÖc víi AutoCAD 

- LÖnh Quit, Exit: LÖnh Exit  cã chøc n¨ng 
t−¬ng tù lÖnh Quit nh−ng nã sÏ tù ®éng ghi l¹i 
nh÷ng thay ®æi trong b¶n vÏ hiÖn hµnh (t−¬ng 
øng víi Yes cña hép tho¹i AutoCAD h×nh 2.7) 

- Ta cã thÓ tho¸t khái AutoCAD 2000 b»ng 
c¸ch nhËp vµo biÓu t−îng AutoCAD t¹i gãc tr¸i 
phÝa trªn mµn h×nh vµ chän close 

8. BiÕn save time 

- LÖnh save time: BiÕn qui ®Þnh thêi gian save tù ®éng cña AutoCAD, thêi gian 
®−îc quy ®Þnh b»ng   

- NhËp lÖnh: 2 c¸ch 

+ Trªn menu chÝnh ta chän tool → chän options (H×nh 13. 2.8) 

� Chän chän môc Open and save 

� Chän nót Automatic save  

� NhËp gi¸ trÞ vµo « Minutes between saves 
 

 
H×nh 13. 2.8 

 
H×nh 13. 13.2.7 
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+ T¹i dßng command: ta nhËp Savetime↵ 
� Command: save time 
� New value for save time <120> 10 

9. Giíi h¹n b¶n vÏ 

- LÖnh: Limits giíi h¹n vïng kÝch th−íc ®å ho¹ 
- NhËp lÖnh: 

+ Menu → Format → Drawing limits 

+ Command: Limits↵ 

Command: Limits↵↵↵↵ 

Specify lower left corner or [ON/OFF] <0.0000,0.0000>:↵ (§iÓm gãc tr¸i phÝa 
d−íi ®−îc ®Æt trïng víi gèc to¹ ®é) 

Specify upper right corner <420.0000,297.0000>: 594,420↵ (§Þnh gi¸ trÞ gãc 
trªn bªn ph¶i ®Ó giíi h¹n b¶n vÏ. 594,420 lµ gi¸ trÞ khæ giÊy A2 ) 

- LÖnh: Zoom LÖnh dïng ®Ó ®−a toµn bé vïng vÏ n»m trªn mµn h×nh ta chän All 

Command: ZOOM↵↵↵↵ 

Specify corner of window, enter a scale factor (nX or nXP), or 

[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: All↵ 

(0,0)

(594,420)

(594,420)

(0,0)

 
                                  a) Tr−íc khi Zoom - All                    b) Sau khi Zoom 

H×nh 13. 2.9 

10. LÖnh Ortho 

- LÖnh Ortho thiÕt lËp chÕ ®é vÏ line theo ph−¬ng cña c¸c sîi tãc (Theo ph−¬ng 
X n»m ngang, theo ph−¬ng Y th¼ng ®øng) 

- Command: Ortho 

- Enter mode [ON/OFF] <OFF>: ON↵ (C¸c lùa chän ON, OFF vµ nhÊn Enter) 
- C¸c lùa chän: 
+ ON      Më chÕ ®é vÏ ORTHO, cã thÓ nhÊn phÝm F8 hoÆc Ctrl-L 
+ OFF    T¾t chÕ ®é vÏ ORTHO 
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Bµi 3 

Sö dông c¸c lÖnh vÏ c¬ b¶n 
vµ nhËp ®iÓm chÝnh x¸c 

M· bµi: MH CG1 13 16 

I. Giíi thiÖu: 

- Bµi häc nµy gióp cho häc sinh biÕt c¸ch x¸c ®Þnh hÖ to¹ ®é cho mçi tr−êng 
hîp, c¸ch nhËp to¹ ®é cña ®iÓm 

- C¸c ph−¬ng thøc truy b¾t ®iÓm thuéc ®èi t−îng.  

III. Môc tiªu thùc hiÖn: 

- X¸c ®Þnh ®−îc to¹ ®é cña c¸c ®iÓm trong hÖ to¹ ®é ®Ò c¸c, to¹ ®é cùc  

- VÏ ®−îc c¸c ®o¹n th¼ng, ®−êng trßn b»ng ph−¬ng ph¸p nhËp to¹ ®é vµ b»ng 
ph−¬ng thøc truy b¾t ®iÓm.  

III. Néi dung chÝnh: 

1. HÖ to¹ ®é sö dông trong AutoCAD. 

2. C¸c ph−¬ng ph¸p nhËp to¹ ®é ®iÓm. 

3. VÏ ®o¹n th¼ng (lÖnh Line) vµ c¸c ph−¬ng ph¸p nhËp ®iÓm. 

4. VÏ ®−êng trßn (lÖnh Circle) sö dông c¸c ph−¬ng ph¸p nhËp ®iÓm. 

5. C¸c ph−¬ng thøc truy b¾t ®iÓm cña ®èi t−îng (Object Snap). 

6. C¸c vÝ dô sö dông ph−¬ng thøc b¾t ®iÓm. 

7. G¸n chÕ ®é truy b¾t th−êng tró (lÖnh Osnap). 

8. Bµi tËp.  

 IV.  C¸c h×nh thøc häc tËp: 

- Häc trªn líp vÒ c¸c hÖ to¹ ®é sö dông trong AutoCAD 

- X¸c ®Þnh to¹ ®é cña c¸c ®iÓm trªn b¶n vÏ. 

- VÏ ®o¹n th¼ng, ®−êng trßn b»ng ph−¬ng ph¸p nhËp to¹ ®é vµ truy b¾t ®iÓm. 

- Gi¸o viªn dïng m¸y chiÕu Projector chiÕu b¶n vÏ lªn b¶ng yªu cÇu häc sinh 
x¸c ®Þnh to¹ ®é c¸c ®iÓm. H−íng dÉn c¸ch vÏ ®o¹n th¼ng, ®−êng trßn b»ng ph−¬ng 
thøc nhËp to¹ ®é vµ b»ng ph−¬ng thøc truy b¾t ®iÓm. 
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1. HÖ to¹ ®é sö dông trong AutoCAD 

1.1. HÖ to¹ ®é §Òc¸c  

HÖ to¹ ®é hai chiÒu (2D) ®−îc thiÕt lËp bëi mét ®iÓm gèc to¹ ®é lµ giao ®iÓm 
cña hai trôc täa ®é vu«ng gãc: Trôc hoµnh X n»m ngang, trôc tung Y th¼ng ®øng. 
§iÓm gèc ®−îc g¸n cho to¹ ®é 0,0. Mét ®iÓm trong hÖ to¹ ®é hai chiÒu (2D) x¸c 
®Þnh bëi hai gi¸ trÞ: Hoµnh ®é X vµ tung ®é Y. DÊu + (d−¬ng), dÊu – (©m) tuú thuéc 
vµo vÞ trÝ ®iÓm so víi c¸c trôc to¹ ®é (H×nh 13. 3.1). Trong b¶n vÏ ba chiÒu (3D) ph¶i 
nhËp thªm cao ®é (Z). To¹ ®é cña mét ®iÓm ®−îc x¸c ®Þnh bëi (X,Y). 

VÝ dô: To¹ ®é cña ®iÓm A (40,50); B (-30,50); C (-30,-40); D (40,-40). 

 
H×nh 13.3.1 

1.2. HÖ to¹ ®é cùc 

- To¹ ®é cùc ®−îc sö dông ®Ó ®Þnh vÞ trÝ 
cña mét ®iÓm trong mÆt ph¼ng to¹ ®é XY. 
To¹ ®é cùc chØ ®Þnh kho¶ng c¸ch vµ gãc so 
víi gèc to¹ ®é (0,0). §iÓm P1 trªn (H×nh 13. 
3.2 ) cã to¹ ®é cùc lµ 120<60. §−êng chuÈn 
®o gãc theo chiÒu d−¬ng trôc X cña hÖ to¹ 
®é ®Ò c¸c. Gãc d−¬ng lµ gãc tÝnh theo chiÒu 
ng−îc chiÒu kim ®ång hå. 

2. C¸c ph−¬ng ph¸p nhËp to¹ ®é 
®iÓm 

1. Dïng phÝm chän (PICK): Dïng 
phÝm tr¸i cña chuét kÕt hîp víi ph−¬ng thøc 
truy b¾t ®iÓm. 

 
H×nh 13.3.2 
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2. To¹ ®é tuyÖt ®èi: NhËp to¹ ®é tuyÖt ®èi cña ®iÓm (X,Y) theo gèc to¹ ®é ®Ò 
C¸c (0,0) gi¸ trÞ nh− môc 3.1.1 

3. To¹ ®é cùc: NhËp to¹ ®é cùc cña ®iÓm (D<α) trong ®ã: D lµ kho¶ng c¸ch 

gi÷a ®iÓm ®Õn gèc to¹ ®é (0,0); α lµ gãc nghiªng hîp bëi ®−êng nèi tõ gèc to¹ ®é 
(0,0) ®Õn ®iÓm víi trôc hoµnh X 

4. To¹ ®é t−¬ng ®èi: NhËp to¹ ®é cña ®iÓm theo ®iÓm cuèi cïng nhÊt trªn b¶n 
vÏ (hay xem ®iÓm võa nhËp lµm gèc to¹ ®é): T¹i dßng nh¾c ta nhËp @ X,Y 

5. To¹ ®é cùc t−¬ng ®èi: T¹i dßng nh¾c ta nhËp @ D<αααα trong ®ã: 

D - lµ kho¶ng c¸ch gi÷a ®iÓm ta cÇn x¸c ®Þnh vµ ®iÓm x¸c ®Þnh cuèi cïng nhÊt. 

α - lµ gãc gi÷a ®−êng chuÈn vµ ®−êng nèi hai ®iÓm. 

6. NhËp kho¶ng c¸ch trùc tiÕp: NhËp gi¸ trÞ kho¶ng c¸ch t−¬ng ®èi víi ®iÓm 
cuèi cïng nhÊt, ®Þnh h−íng b»ng Cursor vµ nhÊn Enter. 

7. Polar tracking: Sö dông polar tracking ®Ó nhËp to¹ ®é ®iÓm theo h−íng ®Þnh 
tr−íc, ta chØ cÇn nhËp gi¸ trÞ kho¶ng c¸ch cßn gãc nghiªng ®−îc mÆc ®Þnh s½n trªn 
hép tho¹i Drafting setting, trang polar tracking 

3. VÏ ®o¹n th¼ng (lÖnh Line) vµ c¸c ph−¬ng ph¸p nhËp ®iÓm 

- LÖnh Line: Dïng ®Ó vÏ c¸c ®o¹n th¼ng. (®o¹n th¼ng cã thÓ n»m ngang, th¼ng 
®øng hoÆc nghiªng), trong lÖnh nµy ta chØ cÇn nhËp to¹ ®é c¸c ®Ønh vµ ®o¹n th¼ng sÏ 
nèi c¸c ®Ønh l¹i víi nhau.  

- NhËp lÖnh: 3 c¸ch 

+ Trªn menu chÝnh ta chän Draw → chän line 

+ command: nhËp line (hoÆc nhËp ch÷ l) ↵ 

+ Trªn Draw toolbar ta nhÊn chuét tr¸i vµo biÓu t−îng 

Command: line ↵ 

Specify first point: (NhËp to¹ ®é ®Ønh ®Çu tiªn cña ®o¹n th¼ng) 

Specify next point or [ Undo ] : (NhËp to¹ ®é ®iÓm cuèi cña ®o¹n th¼ng). 

Specify next point or [ Undo/close ] : (NhËp to¹ ®é ®iÓm tiÕp theo ®Ó vÏ ®o¹n 
th¼ng tiÕp theo hoÆc NhÊn Enter ®Ó kÕt thóc lÖnh) 

VÝ dô 1: Sö dông to¹ ®é tuyÖt ®èi vµ t−¬ng ®èi. 

- VÏ h×nh b×nh hµnh cã kÝch th−íc nh− h×nh 3.1 

- §Çu tiªn ta dïng lÖnh New, chän Metric trªn trang start from scratch cña hép 
tho¹i create New Drawing, sau ®ã dïng lÖnh zoom vµ chän lùa chän All ®Ó ®−a vïng 
vÏ n»m trong vïng hiÓn thÞ cña mµn h×nh.   
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H×nh 13.3.1 

    
1. Sö dông to¹ ®é tuyÖt ®èi 

Command: line ↵ 

Specify first point: 50,50 ↵ 

Specify next point or [ Undo ] :170,50↵ 

Specify next point or [ Undo/close ] : 210,130↵ 

Specify next point or [ Undo/close ] : 90,130↵ 

Specify next point or [ Undo/close ] : 50,50↵ (hoÆc close) 

Specify next point or [ Undo/close ] : ↵ 

Command: 
  
2. Sö dông to¹ ®é t−¬ng ®èi 

Command: line ↵ 

Specify first point: chän ®iÓm bÊt kú b»ng chuét 

Specify next point or [ Undo ] : @120,0 ↵ 

Specify next point or [Undo/close]: @40,80↵ 

Specify next point or [Undo/close]: @120,0↵ 

Specify next point or [Undo/close]: @40,-80↵ (hoÆc close) 

Specify next point or [Undo/close] : ↵ 

Command: 

3. Sö dông to¹ ®é cùc t−¬ng ®èi 

VÏ h×nh thoi c¹nh 100 (H×nh 13. 3.2) 

Command: line ↵ 

Specify first point: chän ®iÓm bÊt kú 
b»ng chuét 
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Specify next point or [ Undo ] : @100<0 ↵ 

Specify next point or [ Undo/close ] : @100<60↵ 

Specify next point or [ Undo/close ] : @100<180↵    

Specify next point or [ Undo/close ] : @100<240↵ (hoÆc close) 

Specify next point or [ Undo/close ] : ↵ 

Command:                                                                               

4. Sö dông to¹ ®é cùc t−¬ng ®èi 

- Sö dông lÖnh vÏ trùc tiÕp ®Ó vÏ h×nh ch÷ nhËt (H×nh 13. 3.3) tr−íc khi vÏ ta 
chän chÕ ®é ORTHO lµ ON (cã thÓ më nót ORTHO trªn dßng tr¹ng th¸i) hoÆc nhÊn 
phÝm F8 

Command: line ↵ 

Specify first point: chän ®iÓm bÊt kú b»ng chuét 

Specify next point or [ Undo ] : 120 ↵ (Rª chuét sang ph¶i vµ Enter) 

Specify next point or [ Undo/close ] :80↵(Rª chuét lªn phÝa trªn vµ Enter) 

Specify next point or [ Undo/close ] : 120↵(Rª chuét sang tr¸i vµ Enter) 

Specify next point or [ Undo/close ] : 80↵ (Rª chuét xuèng d−íi vµ Enter hoÆc 
nhËp c) 

Specify next point or [ Undo/close ] : ↵ 

Command: 

120

80

120Chän bÊt kú
P1 P2

P3
P4

From point

 
H×nh 13. 3.3 

4. VÏ ®−êng trßn (lÖnh Circle) sö dông c¸c ph−¬ng ph¸p nhËp ®iÓm 

- LÖnh Circle: Dïng ®Ó vÏ ®−êng trßn. Cã 5 ph−¬ng ph¸p kh¸c nhau vÏ ®−êng 
trßn. Trong phÇn nµy chØ giíi thiÖu ph−¬ng ph¸p.  



 30 

- NhËp lÖnh: 3 c¸ch 

+ Trªn menu chÝnh ta chän Draw → chän line 

+ T¹i dßng command: ta nhËp line (hoÆc nhËp ch÷ l) ↵ 

+ Trªn thanh Draw toolbar ta nhÊn chuét tr¸i vµo biÓu t−îng 

Command: Circle ↵ (hoÆc nhËp c) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : (NhËp to¹ ®é t©m 

®−êng trßn hoÆc chän chÕ ®é vÏ ®−êng trßn qua 3 ®iÓm 3P, qua 2 ®iÓm 2P, tiÕp xóc 
víi 2 ®èi t−îng vÏ vµ b¸n kÝnh Ttr) 

Specify radius of circle or [Diameter] : (NhËp b¸n kÝnh ®−êng trßn hoÆc nhËp D 

®Ó vÏ ®−êng trßn theo ®−êng kÝnh). 

4.1. VÏ ®−êng trßn T©m, b¸n kÝnh (Center, Radius) 

- VÏ ®−êng trßn b»ng ph−¬ng ph¸p nhËp t©m (Center) vµ b¸n kÝnh (Radius). 
(H×nh 13. 3.5a) 

Command: Circle ↵ (hoÆc nhËp c) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : (NhËp to¹ ®é t©m 
®−êng trßn) 

Specify radius of circle or [Diameter] : (NhËp b¸n kÝnh ®−êng trßn).  

 

 

   Center    Center 

 

 

             Radius        Diameter 

   a) T©m, b¸n kÝnh   b) T©m, ®−êng kÝnh 

H×nh 13. 3.5 

 

4.2. VÏ ®−êng trßn T©m, ®−êng kÝnh (Center, Diameter) 

- VÏ ®−êng trßn b»ng ph−¬ng ph¸p nhËp t©m (Center) vµ ®−êng kÝnh (Diameter). 
(H×nh 13. 3.5b) 

Command: Circle ↵ (hoÆc nhËp c) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : (NhËp to¹ ®é t©m 

®−êng trßn) 
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Specify radius of circle or [Diameter] : 
(NhËp D ®Ó vÏ ®−êng trßn theo ®−êng kÝnh).  

Diameter: (NhËp ®−êng kÝnh ®−êng trßn) 
VÝ dô:  
- Sö dông lÖnh Circle vµ to¹ ®é t−¬ng ®èi vµ 

to¹ ®é cùc t−¬ng ®èi ®Ó vÏ c¸c ®−êng trßn tiÕp 
xóc víi nhau (H×nh 13. 3.6) 

Command: Circle ↵ (hoÆc nhËp c) 

Specify center point for circle or [3P/2P/Ttr 
(tan tan radius)]: (Chän ®iÓm O1 bÊt kú) 

Specify radius of circle or [Diameter] : 30↵ 

Command: ↵ (hoÆc nhËp C↵) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : @60,0 

Specify radius of circle or [Diameter] : 30↵ 

Command: ↵ (hoÆc nhËp C↵) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : @60<120↵ 

Specify radius of circle or [Diameter] : 30↵ 

4.3.  VÏ ®−êng trßn qua ba ®iÓm (3P) 

- VÏ ®−êng trßn qua ba ®iÓm (H×nh 13. 3.28) 

Command: C↵ 

Specify center point for Circle or [ (3P/2P/Ttr (tan tan radius)]: 3P↵ 

Specify first point on Circle: (NhËp ®iÓm thø nhÊt, vÝ dô P1 H×nh 4.28) 

Specify second point on Circle: (NhËp ®iÓm thø hai, vÝ dô P2 H×nh 4.28) 

Specify third  point on Circle: (NhËp ®iÓm thø ba, vÝ dô P3 H×nh 4.28) 
Command:     

P1

P2

P3 P1

P2

P3

P1

P2 P3

Endpoint

Tangent

 
a) §−êng trßn ®i qua      b) §−êng trßn ngo¹i 

     ba ®iÓm bÊt kú                              tiÕp tam gi¸c 

H×nh 13. 3.28 

c) §−êng trßn néi      
tiÕp tam gi¸c  

Ø60

60

O1 O2

O3

C3

C2

C1

 
H×nh 13. 3.6 
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- §Ó vÏ ®−êng trßn ngo¹i tiÕp tam gi¸c (H×nh 13. 3.28 b) ta sö dông ph−¬ng thøc 
truy b¾t ®iÓm ENDpoint . 

- §Ó vÏ ®−êng trßn néi tiÕp tam gi¸c (H×nh 13. 3.28 c) ta sö dông ph−¬ng thøc 
truy b¾t ®iÓm TANgent. 

4.4. VÏ ®−êng trßn qua hai ®iÓm (2P) 

- VÏ ®−êng trßn qua hai ®iÓm (H×nh 13. 3.29) Hai ®iÓm ®ã ph¶i lµ hai ®iÓm 
thuéc ®−êng kÝnh ®−êng trßn. 

 
Command: C↵ 

Specify center point for Circle or [ (3P/2P/Ttr (tan tan radius)]: 2P↵ 

Specify first end point of Circle’s Diameter: (NhËp ®iÓm ®Çu ®−êng kÝnh, vÝ dô 
P1 H×nh 13.3.29 a) 

Specify second end point of Circle’s Diameter: (NhËp ®iÓm  ®Çu ®−êng kÝnh, vÝ 
dô P2 H×nh 13.3.29 a) 

P2

P1

Quadrant Center

P1 P2
P1

P3

P2

Endpoint

Endpoint

 

              

 H×nh 13.3.29. §−êng trßn ®i qua hai ®iÓm 
 

4.5. VÏ ®−êng trßn tiÕp xóc víi hai ®èi t−îng vµ cã b¸n kÝnh R (Ttr) 
  
- Sö dông ph−¬ng ph¸p nµy ®Ó vÏ ®−êng trßn tiÕp xóc víi hai ®èi t−îng cho 

tr−íc b¸n kÝnh R (H×nh 13.3.30a). 

Command: C↵ 

Specify center point for Circle or [ (3P/2P/Ttr (tan tan radius)]: ttr↵ 

Specify point on object for first tangent of Circle: (Chän ®èi t−îng thø nhÊt 
®−êng trßn sÏ tiÕp xóc, vÝ dô P1 H×nh 13.3.30 a) 

Specify point on object for second tangent of Circle: (Chän ®èi t−îng thø hai 
®−êng trßn sÏ tiÕp xóc, vÝ dô P1 H×nh 13..330 b) 

Specify radius of Circle: (NhËp gi¸ trÞ b¸n kÝnh vÝ dô: NhËp b¸n kÝnh R50) 

a) b) c) 
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Tangent

P3

Tangent

Radius 50
Tangent

Tangent

Radius 30

O1 O2

 
      
 

H×nh 13. 3.30. VÏ ®−êng trßn theo ph−¬ng ph¸p Tan Tan Radius 

5. VÏ cung trßn  

- LÖnh: Arc 

LÖnh Arc dïng ®Ó vÏ c¸c cung trßn  

- NhËp lÖnh: 3 c¸ch 

+ Menu → Draw → Pull - down Menu → Arc (H×nh 13. 2.31) 

+ Draw toolbar → chän biÓu t−îng  

+ Command: Arc ↵ (hoÆc NhËp A↵) 

 
H×nh 13. 3.31. Chän lÖnh vÏ cung trßn Arc trªn Menu  

a) §−êng trßn tiÕp xóc víi 
2 ®−êng th¼ng 

b) §−êng trßn tiÕp xóc víi 2 
®−êng trßn cho tr−íc 
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5.1.  VÏ cung trßn qua ba ®iÓm: 

- VÏ cung trßn qua ba ®iÓm (H×nh 13. 3.32) 

Command: Arc↵ 

Specify start point of arc or [ CEnter]: (NhËp ®iÓm P1)↵ 

Specify second point of arc or  [ CEnter/ENd]: (NhËp ®iÓm P2) 

Specify end point of arc: (NhËp ®iÓm P3) 
P1

P3

P2
P2

P1

Endpoint

P3

Endpoint

Endpoint

 

 

H×nh 13. 3.32. VÏ cung trßn 

5.2.  VÏ cung trßn ®iÓm ®Çu, t©m, ®iÓm cuèi (Start, Center, End): 

- NhËp hoÆc b¾t ®iÓm lÇn l−ît ®iÓm ®Çu, t©m vµ ®iÓm cuèi (H×nh 13. 3.33) 

Command: Arc↵ 

Specify start point of arc or [ CEnter]: (NhËp to¹ ®é ®iÓm ®Çu S)↵ 

Specify second point of arc or  [ CEnter/ENd]: CE↵ (NhËp CE ®Ó vÏ theo chÕ 
®é t©m cung trßn) 

Specify center point of arc: (NhËp to¹ ®é t©m cung trßn) 

Specify end point of arc[ Angle/chord/Length] : (NhËp to¹ ®é ®iÓm cuèi E) 

S

E

C Endpoint

S
E

Endpoint
C

 
H×nh 13. 3.33. VÏ cung trßn theo Start, Center, End. 

a) VÏ cung trßn qua 3 ®iÓm b) VÏ cung trßn qua 3 ®Ønh tam gi¸c 



 35 

5.3. VÏ cung trßn ®iÓm ®Çu, t©m, Gãc ë t©m (Start, Center, Angle): 

- NhËp hoÆc b¾t ®iÓm lÇn l−ît ®iÓm ®Çu, t©m vµ gãc ë t©m (H×nh 13. 3.34) 

Command: Arc↵ 

Specify start point of arc or [ CEnter]: (NhËp to¹ ®é ®iÓm ®Çu S)↵ 

Specify second point of arc or  [ CEnter/ENd]: CE↵ (NhËp CE ®Ó vÏ theo chÕ 
®é t©m cung trßn) 

Specify center point of arc: (NhËp to¹ ®é t©m cung trßn) 
Specify end point of arc[ Angle/chord/Length] : A↵ (NhËp A ®Ó vÏ cung trßn 

theo gãc ë t©m) 
Specify included Angle: (NhËp gi¸ trÞ gãc ë t©m) 
Command: 

S

C

Angle

E
S

60°

E

C

Endpoint

Endpoint

 

 

H×nh 13. 3.34. VÏ cung trßn ®iÓm ®Çu, t©m, Gãc ë t©m 

- Chó ý:  

+ Gi¸ trÞ gãc cã thÓ nhËp gi¸ trÞ ©m hoÆc gi¸ trÞ d−¬ng ( Gi¸ trÞ d−¬ng khi gãc 
tÝnh theo ng−îc chiÒu kim ®ång hå, gi¸ trÞ ©m khi tÝnh gãc cïng chiÒu kim ®ång hå) 

+ Cung trßn bao giê còng vÏ theo ng−îc chiÒu kim ®ång hå 

5.4.  VÏ cung trßn ®iÓm ®Çu, ®iÓm cuèi vµ b¸n kÝnh (Start, End, Raius): 

- NhËp hoÆc b¾t ®iÓm lÇn l−ît ®iÓm ®Çu, ®iÓm cuèi vµ b¸n kÝnh (H×nh 13. 3.35) 

Command: Arc↵ 

Specify start point of arc or [ CEnter]: (NhËp to¹ ®é ®iÓm ®Çu S)↵ 

Specify second point of arc or  [ CEnter/ENd]: EN↵ (NhËp EN ®Ó vÏ theo chÕ 
®é ®iÓm cuèi cung trßn) 

Specify end point of arc: (NhËp to¹ ®é ®iÓm cuèi E cung trßn) 

Specify center point of arc or [ Angle/Direction/Radius] : R↵ (NhËp R ®Ó vÏ 
cung trßn theo b¸n kÝnh cung trßn) 

Specify radius of arc: (NhËp gi¸ trÞ b¸n kÝnh cung trßn) 
Command: 

a) VÏ cung trßn theo ®iÓm ®Çu, 
®iÓm cuèi vµ gãc 

b) VÏ cung trßn qua hai c¹nh cña 
tam gi¸c ®Òu 

Angle 60° 
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110

70 R30

P1 P2

P5 P4

P3

C

40

80

S

R
E

E S

R
30

 
H×nh 13. 3.35. VÏ cung trßn ®iÓm ®Çu, ®iÓm cuèi vµ b¸n kÝnh (Start, End, Raius) 

5.5. VÏ cung trßn ®iÓm ®Çu, ®iÓm cuèi vµ Gãc ë t©m (Start, End, Angle) 

- NhËp hoÆc b¾t ®iÓm lÇn l−ît ®iÓm ®Çu, ®iÓm cuèi vµ gãc ë t©m (H×nh 13. 3.36) 

Command: Arc↵ 

Specify start point of arc or [ CEnter]: (NhËp to¹ ®é ®iÓm ®Çu S)↵ 

Specify second point of arc or  [ CEnter/ENd]: EN↵ (NhËp EN ®Ó vÏ theo chÕ 
®é ®iÓm cuèi cung trßn) 

Specify end point of arc: (NhËp to¹ ®é ®iÓm 
cuèi E cung trßn) 

Specify center point of arc or [ 
Angle/Direction/Radius] : A↵ (NhËp A ®Ó vÏ cung 
trßn theo gãc ë t©m cung trßn) 

Specify included angle: (NhËp gi¸ trÞ gãc ë 
t©m cung trßn) 

- VÝ dô: Sö dông lÖnh Line vµ Arc ®Ó vÏ 
(H×nh 13. 3.37) 

1. VÏ ®o¹n th¼ng P1P2. 

Command: Line↵ 

Specify first point: (chän P1 bÊt kú) 

Specify next point or [ Undo]:@80,0↵ 

Specify next point or [ Undo/Close]:↵ 
Command: 
2. VÏ cung P2P3: 

Command: Arc↵ 

Specify start point of arc or [ CEnter]: @↵ 

Specify second point of arc or [ CEnter/ENd]: C↵ 

Specify center point of arc: @30,0↵  

Specify end point of arc or [ Angle/Chord/Length] : A↵ 

Specify included angle: -90 

H×nh 3.37 

S

E

Angle

 
H×nh 13.3.36. VÏ cung trßn  

®iÓm ®Çu, ®iÓm cuèi vµ Gãc ë t©m  
(Start, End, Angle) 
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3. VÏ c¸c ®o¹n th¼ng P3P4, P4P5, P5P1: 

Command: Line↵ 

Specify first point: @↵ 

Specify next point or [ Undo]:@0,40↵ 

Specify next point or [ Undo]:@-110,0↵ 

Specify next point or [ Undo]:@0,-70↵ 

Specify next point or [ Undo/Close]:↵ 
Command: 

6.  VÏ ®a tuyÕn (lÖnh Pline) 

- LÖnh Pline thùc hiÖn nhiÒu chøc n¨ng h¬n lÖnh line. 
- LÖnh Pline cã ba ®Æc ®iÓm næi bËt sau: 
1. LÖnh Pline t¹o c¸c ®èi t−îng cã chiÒu réng (Width), cßn lÖnh line thi kh«ng 
2. C¸c ph©n ®o¹n Pline liªn kÕt thµnh mét ®èi t−îng duy nhÊt. Cßn Line c¸c 

ph©n ®o¹n lµ c¸c ®èi t−îng ®¬n (H×nh 13. 3.38 b) 
3. LÖnh Pline t¹o nªn c¸c ph©n ®o¹n lµ c¸c ®o¹n th¼ng hoÆc c¸c cung trßn (H×nh 

13. 3.38 c) 
- C¸ch vµo lÖnh: 3 c¸ch 
+ Trªn Menu → Draw → Chän Polyline  

+ Trªn Draw toolbar → ta chän biÓu t−îng 
+ Command: Pline↵ 

Pline

Pline (1 object)

Line

a)

3 Line
(3 objects)

(6 objects)
5 Line, 1 arc Pline (1 object)

b)

c)

6 Segments

 

H×nh 13.3.38. Sù kh¸c nhau gi÷a 
Pline, line vµ arc 
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6.1. ChÕ ®é vÏ ®o¹n th¼ng: 

Command: Pline↵ 

Specify start point: (NhËp ®iÓm b¾t ®Çu cña Pline) 

Current line-width is 0.0000 (chiÒu réng hiÖn hµnh lµ 0) 

Speify next point or [ Arc/Close/Halfwidth/Lengt/Undo/Width]: (NhËp to¹ ®é 
®iÓm kÕ tiÕp, truy b¾t ®iÓm hoÆc sö dông c¸c lùa chän) 

C¸c lùa chän: 

Close:            §ãng Pline bëi mét ®o¹n th¼ng. 

Halfwidth:    §Þnh n÷a chiÒu réng s¾p vÏ (H×nh 13.3.39 a). 

                 Starting Halfwidth <>: (NhËp gi¸ trÞ n÷a chiÒu réng ph©n ®o¹n). 

                  Ending half width <>: (NhËp gi¸ trÞ chiÒu réng cuèi ph©n). 

Width:         §Þnh chiÒu réng ph©n ®o¹n s¾p vÏ. (H×nh 13. 3.39 b)   

Starting Halfwidth

Starting Halfwidth

Ending Halfwidth

Ending Halfwidth

Starting Width

Starting Width

Ending Width

Ending Width

a) b)
 

H×nh 13. 3.39 

Length: VÏ tiÕp mét ph©n ®o¹n cã ph−¬ng chiÒu nh− ®o¹n th¼ng tr−íc ®ã (®o¹n 
th¼ng 3-4 H×nh 13.3.40 a). NÕu ph©n ®o¹n tr−íc ®ã lµ cung trßn th× nã sÏ tiÕp xóc 
cung trßn (H×nh 13.3.40 b). 

Length of line: (NhËp chiÒu dµi ph©n ®o¹n s¾p vÏ) 
Undo: Huû bá ph©n ®o¹n võa vÏ 
  

1

2

3 4

Length

Start point

Length

2

Start point
1

3 4

a) b)  
H×nh 13. 3.40  
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6.2. ChÕ ®é vÏ cung trßn: 

- Khi ta nhËp A t¹i dßng nh¾c vÏ ®o¹n th¼ng Pline 

Command: Pline↵ (H×nh 13. 3.41) 

Specify start point: (NhËp ®iÓm b¾t ®Çu cña Pline) 

Current line-width is 0.0000 (chiÒu réng hiÖn hµnh lµ 0) 

Speify next point or [ Arc/Close/Halfwidth/Lengt/Undo/Width]: A↵ (ChuyÓn 
sang chÕ ®é vÏ cung trßn) 

Specify endpoint of arc or [Angle/Center/Close/Direction/Halfwidth/ Line/ 
Radius/ Second pt /Undo/Width]: 

C¸c lùa chän 

 Close: Cho phÐp ta ®ãng ®a tuyÕn bëi mét cung trßn 

 Halfwidth, Width, Undo: T−¬ng tù nh− chÕ ®é vÏ ®o¹n th¼ng 

  Angle: T−¬ng tù lÖnh Arc khi ta nhËp sÏ cã dßng nh¾c 

  Specify included angle: gãc ë t©m 

   Specify endpoint of arc or [Center/ radius]: (NhËp to¹ ®é ®iÓm cuèi 
   cña cung, hoÆc t©m, b¸n kÝnh) 

    Center: T−¬ng tù lÖnh Arc khi ta nhËp CE sÏ cã dßng nh¾c  

  Specify center point of arc: (NhËp to¹ ®é t©m) 

  Specify endpoint of arc or [ Angle /Length]: 

Start point
Pline Arc

Pline Arc
Endpoint 

of Arc  
H×nh 13. 3.41 

Direction: §Þnh h−íng cña ®−êng tiÕp tuyÕn víi giao ®iÓm ®Çu tiªn cña cung  

  Khi ta nhËp D sÏ xuÊt hiÖn dßng nh¾c nh− sau: 

Specify tangent direction for the start point of arc: (NhËp to¹ ®é mét ®iÓm kÕt 
hîp víi ®iÓm ®Çu lµm h−íng tiÕp tuyÕn víi cung trßn)  

Specify endpoint of the arc: (NhËp to¹ ®é ®iÓm cuèi) 
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Radius: X¸c ®Þnh b¸n kÝnh cong cña cung, khi ta nhËp R sÏ xuÊt hiÖn dßng nh¾c   

  Specify radius of arc: (NhËp gi¸ trÞ b¸n kÝnh cña cung trßn) 

Specify endpoint of arc or[ Angle ]: (NhËp to¹ ®é ®iÓm cuèi cña cung hoÆc nhËp 
A ®Ó vÏ cung trßn theo gãc ë t©m) 

Second pt: NhËp to¹ ®é ®iÓm thø hai vµ ®iÓm cuèi ®Ó x¸c ®Þnh cung trßn ®i qua 

ba ®iÓm. Khi ta nhËp S sÏ xuÊt hiÖn dßng nh¾c: 

 Specify second point on arc: (NhËp ®iÓm thø hai) 

  Specify end point of arc: (NhËp to¹ ®é ®iÓm cuèi) 

Line: Trë vÒ chÕ ®é vÏ ®o¹n th¼ng 

VÝ dô:  

 Dïng lÖnh Pline vÏ ®a tuyÕn (H×nh 13.3.42) 

 Command: Pline↵ 

Specify start point: (chän P1) 

Current line-width is 0.0000 

Speify next point or [ Arc/Close/Halfwidth/Lengt/Undo/Width]: @100,0↵  

Speify next point or [ Arc/Close/Halfwidth/Lengt/Undo/Width]:A↵ 

Specify endpoint of arc or [Angle/Center/Close/Direction/Halfwidth/Line/ 

Radius/ Second pt /Undo/Width]:@0,100↵ 

Specify endpoint of arc or [Angle/Center/Close/Direction/Halfwidth/ Line/ 

Radius/ Second pt /Undo/Width]:L↵ 

Speify next point or [ Arc/Close/Halfwidth/Lengt/Undo/Width]: @-50,0↵ 

Speify next point or [ Arc/Close/Halfwidth/Lengt/Undo/Width]:A↵ 

Specify endpoint of arc or [Angle/Center/Close/Direction/Halfwidth/ Line/      

Radius/ Second pt /Undo/Width]:CE↵ 

Specify center point of arc: @-50,0↵ 

 Specify endpoint of arc or [ Angle /Length]:A↵ 

 Specify included angle:-90↵ 

Specify endpoint of arc or [Angle/Center/Close/Direction/Halfwidth/ Line/ 

Radius/ Second pt /Undo/Width]:L↵ 

Speify next point or [ Arc/Close/Halfwidth/Lengt/Undo/Width]: C↵ 
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H×nh 13. 3.42 

7. VÏ h×nh ®a gi¸c ®Òu 

LÖnh: Polygon  

- Dïng ®Ó vÏ ®a gi¸c ®Òu, cã sè ph©n ®o¹n (Segment)  
- C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Draw → Chän Polygon 

+ Draw toolbar → chän biÓu t−îng  

+ Command:Polygon↵ 
7.1.  §a gi¸c ngo¹i tiÕp ®−êng trßn: (Circumscribed about circle)  

- Khi cho tr−íc b¸n kÝnh ®−êng trßn néi tiÕp (H×nh 13. 3.43b) 

Command: Polygon↵ (H×nh 13.3.43 b) 
Enter number of side<4>: (NhËp sè c¹nh ®a gi¸c) 
Specify center of polygon or [ Edge]: (NhËp to¹ ®é t©m cña ®a gi¸c hoÆc [C¹nh]) 
Enter an option[ Inscribed in circle/ Circumscribed about circle]<I>: C↵ 
Specify radius of circle: (NhËp gi¸ trÞ b¸n kÝnh ®−êng trßn néi tiÕp) 

       

Center Center

First point Second point
 

      
 

H×nh 13.3.43 

a) Inscribed 

(Néi tiÕp) 

b) Circumscribed 

(Ngo¹i tiÕp) 
c) Edge 

(C¹nh) 
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7.2.  §a gi¸c ngo¹i tiÕp ®−êng trßn: (Inscribed in circle) 

 - Khi cho tr−íc b¸n kÝnh ®−êng trßn ngo¹i tiÕp ®a gi¸c (H×nh 13.3.43 a) 

Command: Polygon↵  

Enter number of side<4>: (NhËp sè c¹nh ®a gi¸c) 

Specify center of polygon or [ Edge]: (NhËp to¹ ®é t©m cña ®a gi¸c hoÆc [C¹nh]) 

Enter an option[ Inscribed in circle/ Circumscribed about circle]<I>: I↵ 

Specify radius of circle: (NhËp gi¸ trÞ b¸n kÝnh ®−êng trßn ngo¹i tiÕp) 

7.3. VÏ ®a gi¸c theo c¹nh: (Edge)  

- Khi cho tr−íc chiÒu dµi mét c¹nh cña ®a gi¸c (H×nh 13. 3.43 c) 

Command: Polygon↵  

Enter number of side<4>: (NhËp sè c¹nh ®a gi¸c) 

Specify center of polygon or [ Edge]: E↵ 

Specify first endpoint of edge: (NhËp to¹ ®é ®iÓm ®Çu mét c¹nh) 

Specify second endpoint of edge: (NhËp to¹ ®é ®iÓm cuèi cña mét c¹nh) 

8. VÏ h×nh ch÷ nhËt 

LÖnh: Rectang  

- Dïng ®Ó vÏ h×nh ch÷ nhËt, h×nh vu«ng. 

- C¸ch vµo lÖnh: 3 c¸ch 

+ Trªn Menu → Draw → Chän Polygon 

+ Trªn Draw toolbar → ta chän biÓu t−îng  

+ Command:Rectang ↵  (hoÆc nhËp R↵) 

Command: Rectang↵ 

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: (NhËp 
to¹ ®é cña gãc thø nhÊt)  

Specify other corner point: (NhËp to¹ ®é gãc thø hai hay gãc ®èi diÖn) 

- C¸c lùa chän 

Chamfer: Cho phÐp v¸t mÐp 4 ®Ønh h×nh ch÷ nhËt. §Çu tiªn ta nhËp gi¸ trÞ kho¶ng 
c¸ch v¸t mÐp, sau ®ã vÏ h×nh ch÷ nhËt (H×nh 13.3.44 a) 

Command:Rectang↵ 

Specify first corner point or[ Chamfer/Elevation/Fillet/tThickness/Width]: : C↵ 

Specify first chamfer distance for rectangles<0.0000>:10 
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Specify second chamfer distance for rectangles<10.0000>:10 
Specify first corner point or[ Chamfer/Elevation/Fillet/tThickness/Width]: : 

(Chän ®iÓm  P1). 
Specify other corner point: @120,80 

Fillet: Cho phÐp bo trßn c¸c ®Ønh h×nh ch÷ nhËt (H×nh 13. 3.44 b) 

    Command:Rectang↵ 

Specify first corner point or[ Chamfer/Elevation/Fillet/tThickness/Width]: : F↵ 

Specify fillet radius for rectangles<0.0000>:10↵ (NhËp b¸n kÝnh bo trßn gãc 
h×nh ch÷ nhËt) 

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: P1 bÊt 
kú (NhËp to¹ ®é gãc thø nhÊt h×nh ch÷ nhËt) 

Specify other corner point: (NhËp to¹ ®é gãc thø hai h×nh ch÷ nhËt) 
Width: §Þnh chiÒu réng nÐt vÏ (H×nh 13. 3.44 c)   

Command: _rectang 
Current rectangle modes:  Fillet=10.0000 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: w↵ 

Specify line width for rectangles <0.0000>: 4 (§Þnh bÒ réng nÐt vÏ h×nh ch÷ nhËt) 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: P1 bÊt 

kú (NhËp to¹ ®é gãc thø nhÊt h×nh ch÷ nhËt) 
Specify other corner point: (NhËp to¹ ®é gãc thø hai h×nh ch÷ nhËt) 

 
        a)         b) 

4

R
10

120

80

120

80

d)

P2 P2

P1P1  
     c)        d)  

H×nh 13. 3434. Sö dông lÖnh RECTANG víi c¸c lùa chän kh¸c nhau 
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9. VÏ ®−êng ElÝp 

- LÖnh: Ellipse 

- C¸ch vµo lÖnh: 3 c¸ch 

+ Trªn Menu → Draw → Chän Ellipse 

+ Trªn Draw toolbar → ta chän biÓu t−îng    

+ Command:Ellipse↵ (HoÆc nhËp EL↵) 

9.1. VÏ Elip theo to¹ ®é mét trôc vµ kho¶ng c¸ch n÷a trôc cßn l¹i 

Command: Ellipse↵ 

Specify axis endpoint of ellipse or [Arc/Center]: (NhËp to¹ ®é ®iÓm cuèi trôc 
thø nhÊt cña ElÝp) vÝ dô ®iÓm 1 (H×nh 13. 3.45) 

Specify other endpoint of axis: (NhËp to¹ ®é ®iÓm thø 2 ®Ó ®Þnh kho¶ng c¸ch 
trôc ElÝp) 

Specify distance to other axis or [Rotation]: (NhËp to¹ ®é ®iÓm thø 3 hoÆc nhËp 
gi¸ trÞ kho¶ng c¸ch n÷a trôc thø hai) 

  

1 2

3

1 2

A
ngle

 

 
       

H×nh 13. 13.3.45. VÏ elÝp b»ng ph−¬ng ph¸p ®Þnh vÞ trÝ c¸c trôc 
  

9.2. .VÏ ElÝp theo t©m vµ c¸c trôc 

Command: Ellipse↵ 

Specify axis endpoint of ellipse or [Arc/Center]: c↵ 

Specify center of ellipse: (NhËp to¹ ®é t©m cña ElÝp) 

Specify endpoint of axis: (NhËp to¹ ®é ®iÓm cuèi 1 cña trôc ElÝp ®Ó x¸c ®Þnh 
trôc) 

Specify distance to other axis or [Rotation]: (NhËp to¹ ®é ®iÓm thø 2 hoÆc nhËp 
gi¸ trÞ kho¶ng c¸ch n÷a trôc thø hai) (H×nh 13. 3.46) 

a) Endpoints - Distance b) Endpoints - Rotation 
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H×nh 13. 3.46. VÏ elÝp b»ng ph−¬ng ph¸p ®Þnh t©m 

    

9.3. VÏ ElÝp theo cung 

Command: ellipse↵ 

Specify axis endpoint of ellipse or [Arc/Center]: A↵ 

Specify axis endpoint of elliptical arc or [Center]: (NhËp to¹ ®é ®iÓm cuèi thø 
nhÊt cña trôc ) 

Specify other endpoint of axis: (NhËp to¹ ®é ®iÓm cuèi thø hai cña trôc ) 

Specify distance to other axis or [Rotation]: (NhËp gi¸ trÞ kho¶ng c¸ch n÷a trôc 
thø hai) 

Specify start angle or [Parameter]: (NhËp gi¸ trÞ gãc b¾t ®Çu cña cung elÝp) 

Specify end angle or [Parameter/Included angle]: (NhËp gi¸ trÞ gãc cuèi cña 
cung elÝp) (H×nh 13. 3.47) 

  

2

C

1

1C

2

A
ngle

45°

Cung Elip Start Angle

End AngleCung Elip
End Angle

Start Angle
 

H×nh 13. 3.47 

a) Center - Distance b) Center - Rotation 
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10. VÏ ®−êng cong Spline 

-  LÖnh: Spline 
-  C¸ch vµo lÖnh: 3 c¸ch 

�  Trªn Menu → Draw → Chän Spline 

�  Trªn Draw toolbar → chän biÓu t−îng  

� Command:Spline↵  

Command: spline↵ 
Specify first point or [Object]: (NhËp to¹ ®é ®iÓm ®Çu cña Spline VÝ dô: ®iÓm 1 

H×nh 13.3.48) 
Specify next point: (NhËp ®iÓm kÕ tiÕp VÝ dô: ®iÓm 2) 
Specify next point or [Close/Fit tolerance] <start tangent>: (NhËp ®iÓm kÕ tiÕp 

VÝ dô: ®iÓm 3) 
Specify next point or [Close/Fit tolerance] <start tangent>: (NhËp ®iÓm kÕ tiÕp 

VÝ dô: ®iÓm 4) 
Specify next point or [Close/Fit tolerance] <start tangent>: (NhËp ®iÓm kÕ tiÕp 

VÝ dô: ®iÓm 5 hoÆc nhÊn phÝm Enter ®Ó kÕt thóc nhËp to¹ ®é) 
Specify start tangent: (Chän h−íng tiÕp tuyÕn t¹i ®iÓm ®Çu hoÆc nhÊn phÝm 

Enter chän mÆc ®Þnh) 
Specify end tangent: (Chän h−íng tiÕp tuyÕn t¹i ®iÓm cuèi hoÆc nhÊn phÝm Enter 

chän mÆc ®Þnh) 

1

2

3

4
5

a) Spline (Default Tangents)

2

3

5
4

1 c) Spline  ®ãng (Close)

b) Spline (Tangents)

1

3

2
5

4

Start tangent

End tangent

1

3

2
5

4

d) Tolerance = 50
 

H×nh 13.3.48. §−êng Spline 
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C¸c lùa chän 

Object: Lùa chän Objects dïng ®Ó chuyÓn ®−êng Pline vµ lµm tr¬n b»ng lÖnh 
Pedit thµnh ®−êng Spline.   

 Command: Spline↵ 

Specify first point or [Object]: o↵ 

Select objects to convert to splines. (Chän c¸c ®èi t−îng cÇn chuyÓn thµnh 
Spline) 

Select objects: (Chän Pline) 

Select objects:(Chän Pline hoÆc NhÊn Enter ®Ó kÕt thóc lùa chän) 

Close: Cho phÐp ®ãng kÝn Spline (H×nh 13. 3.48 c) 

Fit Tolerance: Lùa chän Fit Tolerance t¹o ®−êng cong Spline mÞn h¬n. Khi gi¸ 
trÞ b»ng 0 ®−êng Spline ®i qua c¸c ®iÓm chän (H×nh 13. 3.37 d) 

Spline
Spline

 
H×nh 13. 3.48. VÝ dô øng dông Spline 

11. VÝ dô sö dông c¸c lÖnh vÏ t¹o h×nh h×nh häc 

Sö dông lÖnh vÏ Ellipse, Circle, Polygon vµ Rectang vÏ (H×nh 13. 3.39) 

1. Sö dông lÖnh vÏ Ellipse vÏ h×nh ElÝp: 

Command: _ellipse ↵ 

Specify axis endpoint of ellipse or [Arc/Center]: 

Specify other endpoint of axis: @200,0↵ 

Specify distance to other axis or [Rotation]: 80↵ 

2. Sö dông lÖnh vÏ Circle vÏ h×nh ®−êng trßn: 

Command: _circle ↵  

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2p 

Specify first end point of circle's diameter:CEN↵ of (Truy b¾t t©m ElÝp) 

Specify second end point of circle's diameter: @80,0↵ 
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3. Sö dông lÖnh vÏ Polygon vÏ ®a gi¸c: 

Command: Polygon ↵ 

Enter number of sides <4>: 6↵ 

Specify center of polygon or [Edge]:CEN↵ of (Truy B¾t t©m ®−êng trßn) 

Enter an option [Inscribed in circle/Circumscribed about circle] <I>: C↵ 

Specify radius of circle: @26,0↵ 
4. Sö dông lÖnh vÏ Rectang ®Ó vÏ r·nh ®−îc bo trßn 

Command: Rectang↵ 
Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]: F 
Specify fillet radius for rectangles 

<0.0000>: 15↵ 
Specify first corner point or 
[Chamfer/Elevation/Fillet/Thickness/Widt]: 

From↵ 

Base point: QUA↵ of (B¾t ®iÓm QUA 
bªn tr¸i cña elÝp) 

<Offset>: @20,-15↵ 

Specify other corner point: @60,30↵ 

 
H×nh 13. 3.50. T¹o h×nh b»ng c¸c lÖnh vÏ Ellipse, Circle, Polygon vµ Rectang 

12. Bµi tËp 

1. Sö dông lÖnh line vµ Arc vÏ c¸c (H×nh 13. 3.51 a; 133.51 b ) 

150

10
0

R50

R68

125

99

 
  

H×nh 13.3.51 
a) b) 
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2. Sö dông lÖnh line, Arc vµ Circle vÏ c¸c h×nh (H×nh 13. 3.51) 

45°

R30

50

R80

R40

R20

40

a) b)

160

80

80

2 Lç R20

50

R50

R50

R20

c) d)  
H×nh 13.3.52 

         
3. Sö dông lÖnh line, Arc, Circle vµ Polygon vÏ c¸c h×nh (H×nh 13.3.52) 
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Point Angle Radius 

1 0 28.25 

2 30 42 

3 60 46.6 

4 90 49 

5 120 46.6 

6 150 42 

7 180 38.25 

8 210 34 

9 240 30.8 

10 270 30 

11 300 30.8 

12 330 34 

 

1. Sö dông lÖnh line, Arc, Circle vµ Circle vÏ c¸c h×nh (H×nh 13. 3.54, H×nh 3.55) 

 
    

H×nh 13.3.54. TÊm ph¼ng 

 

 
 

     

       
     

(H×nh 13. 3.55) Cam 
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2. Sö dông lÖnh line, Arc, Circle vµ Circle vÏ c¸c h×nh (H×nh 13.3.56) 
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Bµi 4 

c¸c ph−¬ng thøc truy b¾t ®iÓm 

M· bµi: MH CG1 13 16 

I. Giíi thiÖu: 

- Bµi häc nµy gióp cho häc sinh nhËp täa ®é chÝnh x¸c b»ng ph−¬ng thøc truy 
b¾t ®iÓm, gióp qu¸ tr×nh vÏ nhanh h¬n. 

II. Môc tiªu thùc hiÖn: 

- Sö dông ®−îc c¸c ph−¬ng thøc truy b¾t ®iÓm t¹m tró vµ th−êng tró 

III. Néi dung chÝnh: 

1. HÖ to¹ ®é sö dông trong AutoCAD. 

2. C¸c ph−¬ng ph¸p nhËp to¹ ®é ®iÓm. 

3. VÏ ®o¹n th¼ng (lÖnh Line) vµ c¸c ph−¬ng ph¸p nhËp ®iÓm. 

4. VÏ ®−êng trßn (lÖnh Circle) sö dông c¸c ph−¬ng ph¸p nhËp ®iÓm. 

5. C¸c ph−¬ng thøc truy b¾t ®iÓm cña ®èi t−îng (Object Snap). 

6. C¸c vÝ dô sö dông ph−¬ng thøc b¾t ®iÓm. 

7. G¸n chÕ ®é truy b¾t th−êng tró (lÖnh Osnap). 

8. Bµi tËp.  

  IV. C¸c h×nh thøc häc tËp: 

- Häc trªn líp vÒ c¸c c¸c ph−¬ng thøc truy b¾t ®iÓm t¹m tró vµ th−êng tró. 

- Gi¸o viªn dïng m¸y chiÕu Projector chiÕu b¶n vÏ lªn b¶ng yªu cÇu häc sinh 
x¸c ®Þnh to¹ ®é c¸c ®iÓm. H−íng dÉn c¸ch vÏ ®o¹n th¼ng, ®−êng trßn b»ng ph−¬ng 
thøc nhËp to¹ ®é vµ b»ng ph−¬ng thøc truy b¾t ®iÓm. 

1.  C¸c ph−¬ng thøc truy b¾t ®iÓm cña ®èi t−îng (Object Snap) 

- Trong khi thùc hiÖn c¸c lÖnh vÏ AutoCAD cã kh¶ n¨ng gäi lµ Object Snap 
(OSNAP) dïng ®Ó truy b¾t c¸c ®iÓm thuéc ®èi t−îng. 

- VÝ dô: C¸c ®iÓm cuèi cña line, ®iÓm gi÷a cña Arc, t©m cña circle, giao ®iÓm 
cña line vµ circle... ta cã thÓ g¸n ph−¬ng thøc truy b¾t ®iÓm theo hai ph−¬ng ph¸p: 
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+ Truy b¾t t¹m tró: chØ sö dông mét lÇn khi truy b¾t mét ®iÓm 

+ Truy b¾t th−êng tró (Running Object Snap): g¸n c¸c ph−¬ng thøc truy b¾t 
®iÓm lµ th−êng tró ®Õn khi t¾t chÕ ®é nµy. 

1.1. Tr×nh tù thùc hiÖn lÖnh truy b¾t t¹m tró:    

1. Ph¶i cã lÖnh ®ßi hái, ph¶i chØ ®Þnh ®iÓm (Specify a point) vÝ dô: lÖnh Arc, 
Circle, Line, Copy, Move... 

2. Khi t¹ dßng nh¾c lÖnh yªu cÇu chØ ®Þnh ®iÓm (Specify a point) ta cã thÓ chän 
c¸c ph−¬ng thøc truy b¾t ®iÓm kh¸c nhau nh− sau: 

- Click vµo biÓu t−îng  trªn thanh c«ng cô Standard Toolbar sÏ tr¶i xuèng 
thanh c«ng cô Object snap (H×nh 13.4.7) 

- Sö dông ®ång thêi phÝm Shift (hoÆc phÝm Ctrl) vµ phÝm ph¶i chuét khi con trá 
chuét n»m trong vïng ®å ho¹ sÏ xuÊt hiÖn shortcut menu. Sau ®ã ta chän danh môc 
cÇn thiÕt trªn shortcut menu. (H×nh 13.4.8) 

          
                   H×nh 13.4.7                                                          H×nh 13.4.8 

(§−a chuét vµo biÓu t−îng )                (NhÊn phÝm Shift vµ phÝm ph¶i chuét) 
  
3. Di chuyÓn « vu«ng truy b¾t (Aperture) ngang qua vÞ trÝ cÇn truy b¾t, khÝ ®ã 

xuÊt hiÖn khung h×nh ký hiÖu ph−¬ng thøc truy b¾t (Marker) hiÖn lªn t¹i ®iÓm cÇn 
truy b¾t vµ Ên phÝm chän chuét (phÝm tr¸i chuét) ®Ó kh¼ng ®Þnh ®iÓm truy b¾t. 

- Trong AutoCAD 2000 ta cã tÊt c¶ 15 ph−¬ng thøc truy b¾t ®iÓm cña ®èi t−îng 
(gäi t¾t lµ truy b¾t ®iÓm) . Ta cã thÓ sö dông truy b¾t ®iÓm th−êng tró hay t¹m tró. 
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- Trong môc nµy giíi thiÖu truy b¾t ®iÓm t¹m tró. 

- C¸c ®iÓm cña ®èi t−îng AutoCAD cã thÓ truy b¾t ®−îc lµ: 

• Line, Spline   :  C¸c ®iÓm cuèi (ENDpoint), ®iÓm gi÷a (MIDpoint) 

• Arc             : C¸c ®iÓm cuèi (ENDpoint), ®iÓm gi÷a (MIDpoint), t©m (CENter), 
®iÓm gãc 1/4 (QUAdrant)  

• Circle, Ellipse:  T©m (CENter), ®iÓm gãc 1/4 (QUAdrant) 

• Point              :  §iÓm t©m NODe 

• Pline, Mline   :  §iÓm cuèi (ENDpoint), ®iÓm gi÷a (MIDpoint) mçi ph©n ®o¹n. 

• Text, Block:  §iÓm chÌn (INSert).  

- Ngoµi ra cßn truy b¾t ®iÓm tiÕp xóc (TANgent), ®iÓm vu«ng gãc 
(PERpendicular), FROM, APPintersection, EXTension, PARallel... 

- §Ó lµm xuÊt hiÖn b¶ng truy b¾t ®iÓm ta cã mét trong c¸c ph−¬ng ph¸p sau: 

1.2. C¸c ph−¬ng thøc truy b¾t ®iÓm.  

1. CENter:  Dïng ®Ó truy b¾t ®iÓm t©m cña Circle, arc, ellipse. Khi truy b¾t ta 
chän ®èi t−îng b¾t t©m. (H×nh 13.4.9) 

                  
         a) Circle                                              b) Arc                                         c) Ellipse 

H×nh 13. 4.9. Truy b¾t ®iÓm CENter. 

2. ENDpoint   

- Dïng ®Ó truy b¾t ®iÓm cuèi cña line, Spline, Arc, ph©n ®o¹n cña pline, Mline. 
Chän ®iÓm gÇn ®iÓm cuèi truy b¾t (H×nh 13. 4.10) 

                        
H×nh 13. 4.10. Truy b¾t ®iÓm cuèi (ENDpoint) 
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3. INSert  

- Dïng ®Ó truy b¾t ®iÓm cña dßng text vµ Block (khèi). Chän mét ®iÓm bÊt kú 
cña dßng text hoÆc Block vµ nhÊn phÝm chän  (H×nh 13.4.11)                                                     

                         

 

 

 
   
 

                a) Text       b) Block 

H×nh 13.4.11. Truy b¾t ®iÓm chÌn (INSert) 

4. INTersection  

- Dïng ®Ó truy b¾t giao ®iÓm cña hai ®èi t−îng. Muèn truy b¾t th× giao ®iÓm 
ph¶i n»m trong « vu«ng truy b¾t hoÆc c¶ hai ®èi t−îng ph¶i n»m trong « vu«ng truy 
b¾t (H×nh 13.4.12) 

                            
H×nh 13. 4.12.  Truy b¾t giao ®iÓm  (INTersection) 

- Ngoµi ra ta cã thÓ chän lÇn l−ît hai ®èi t−îng giao ®Ó truy b¾t giao ®iÓm. Sö 
dông ph−¬ng ph¸p nµy ®Ó truy b¾t giao ®iÓm cña hai ®èi t−îng khi kÐo dµi míi giao 
nhau (H×nh 13.4.13) 

                     
  Giao ®iÓm hai line   Giao ®iÓm Circle vµ Arc 

H×nh 13.4.13.  Truy b¾t giao ®iÓm (INTersection) khi chän lÇn l−ît hai ®èi t−îng 
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5. MIDpoint 

- Dïng ®Ó truy b¾t ®iÓm gi÷a cña mét line, arc, hoÆc Spline. 

- Khi truy b¾t chän mét ®iÓm bÊt kú thuéc ®èi t−îng (H×nh 13.4.14) 

 
H×nh 13. 4.14. Truy b¾t ®iÓm gi÷a (MIDpoint) 

6. NEArest 

- Dïng truy b¾t ®iÓm thuéc ®èi t−îng gÇn giao ®iÓm víi hai sîi tãc nhÊt. 

- Cho « vu«ng truy b¾t ®Õn ch¹m ®èi t−îng gÇn ®iÓm truy b¾t vµ nhÊt phÝm 
chän. (H×nh 13.4.15). 

7. NODe 

- Dïng ®Ó truy b¾t t©m cña mét ®iÓm 

- Cho « vu«ng truy b¾t ®Õn ch¹m víi ®iÓm vµ Ên phÝm chän. (H×nh 13. 4.16) 

 
H×nh 13.4.15.. Truy b¾t NEArest                      (H×nh 13.4.16. Truy b¾t NODe           

8. PERpendicular 

- Truy b¾t ®iÓm vu«ng gãc víi 
®èi t−îng ®−îc chän. 

- Cho « truy b¾t ®Õn ch¹m ®Õn 
víi ®èi t−îng ®−îc chän vµ Ên 
phÝm chän (H×nh 13.4.17) 

9. QUAdrant 

- Dïng truy b¾t ®iÓm 1/4 
Circle, Ellipse hoÆc Arc. 

 
H×nh 13.4.17. Truy b¾t ®iÓm PERpendicular víi line 
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- Cho « vu«ng truy b¾t ®Õn ®Õn gÇn ®iÓm cÇn truy b¾t, ch¹m víi ®èi t−îng vµ Ên 
phÝm chän (H×nh 13.4.18) 

                
H×nh 13. 4.18. Truy b¾t QUAdrant 

10. TANgent 

- Truy b¾t ®iÓm tiÕp xóc víi line, arc, ellipse, spline hoÆc circle. 

- Cho « vu«ng truy b¾t tiÕp xóc víi ®èi t−îng t¹i gÇn ®iÓm cÇn t×m vµ Ên phÝm 
chän. (H×nh 13.4.19) 

 

 

 

 

 

 

 a) Line tiÕp xóc víi ®−êng trßn      b) Line tiÕp xóc víi hai ®−êng trßn     c) Line tiÕp xóc cung trßn 

     
                           d) Line tiÕp xóc víi elÝp                            e) Line tiÕp xóc víi ®−êng Spline 
 

H×nh 13.4.19. Truy b¾t ®iÓm TANgent 
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2. C¸c vÝ dô sö dông ph−¬ng thøc b¾t ®iÓm 

- Sö dông lÖnh line víi c¸c ph−¬ng thøc b¾t ®iÓm ENDpoint, PERpendicular, 
MIDpoint, INTersection vÏ (H×nh 13.4.20). 

- Ta thùc hiÖn b¶n vÏ theo tr×nh tù sau 
- VÏ tam gi¸c P1P2P3 b»ng lÖnh line (H×nh 13.4.20a) 

Command: Line ↵ 
Specify first point: (Chän ®iÓm P1 bÊt kú)    

Specify next point or [Undo]: @160,0↵ 

Specify next point or [Undo/Close]: @80,60↵ 

Specify next point or [Undo/Close]: c↵ 
Command: 
- VÏ ®o¹n th¼ng P3P4, P4P5, P5P6 b»ng lÖnh line víi c¸c ph−¬ng thøc b¾t ®iÓm 

ENDpoint, PERpendicular, MIDpoint (H×nh 13.4.20b) 

Command: Line ↵ 

Specify first point: END ↵ of (B¾t ®iÓm P3)  

Specify next point or [Undo]: PER↵ of (B¾t ®iÓm P4) 

Specify next point or [Undo/Close]: MID↵ of (b¾t ®iÓm P5) 

Specify next point or [Undo/Close]: PER↵ to (b¾t ®iÓm P6) 

Specify next point or [Undo/Close]: ↵ 
Command: 

P1

P3

P2 P1 P2

P3

P5

P6P4

MID

END

PERPER

a) VÏ h×nh tam gi¸c b»ng lÖnh line b) VÏ line víi truy b¾t ®iÓm END, PER, MID.

 

P1
P2

P3

P8 P4 P6

P5P7

P1
P4P8 P6

P2

P7

P3

P5

END

MID

END

PERPER

INT

c) VÏ line víi truy b¾t ®iÓm INT, MID, PER, MID.
 

H×nh 13.4.20. VÏ line víi c¸c ph−¬ng thøc truy b¾t ®iÓm. 

d) VÏ h×nh víi c¸c kÝch th−íc 
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- VÏ c¸c ®o¹n P4P7, P7P8 b»ng lÖnh line víi c¸c ph−¬ng thøc b¾t ®iÓm 
INTersection, MIDpoint, PERpendicular (H×nh 13.4.20c) 

Command: Line ↵ 

Specify first point: INT ↵ of (B¾t ®iÓm P4)  

Specify next point or [Undo]: MID↵ of (B¾t ®iÓm P7) 

Specify next point or [Undo/Close]: PER↵ to (b¾t ®iÓm P8) 

Specify next point or [Undo/Close]: ↵ 

Command: 

- VÝ dô: 2 

VÏ ®o¹n th¼ng tiÕp xóc víi hai ®−êng trßn (H×nh 13.4.21) 
    

 
                a) H×nh chiÕu b»ng    b) M« h×nh 3D 

H×nh 13.4.21 
   
- Tr×nh tù thùc hiÖn: 

1. VÏ hai ®−êng trßn C1, C2 cã t©m O1 víi b¸n kÝnh R1 = 15 vµ R2 = 30 (H×nh 
13.4.21a) 

Command: Circle ↵ (hoÆc nhËp c) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : (Chän ®iÓm O1 
bÊt kú lµm t©m ®−êng trßn) 

Specify radius of circle or [Diameter] : 15↵ 

Command: Circle ↵ (hoÆc nhËp c) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : @↵ (T©m ®−êng 
trßn C2 trïng víi C1) 

Specify radius of circle or [Diameter] : 30↵ 
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H×nh 13.4.22 

     
2. VÏ hai ®−êng trßn C3, C4 cã t©m O2 víi b¸n kÝnh R1 = 30 vµ R2 = 50 (H×nh 

13.4.22a) 

Command: Circle ↵ (hoÆc nhËp c) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : @120,0↵(§Þnh 
t©m O2 theo O1)  

Specify radius of circle or [Diameter] : 30↵ 

Command: Circle ↵ (hoÆc nhËp c) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : @↵ (T©m 
®−êng trßn C4 trïng víi C3) 

Specify radius of circle or [Diameter] : 50↵ 

3. VÏ hai ®o¹n th¼ng P1P3, P2P4 tiÕp xóc víi hai ®−êng trßn C2 vµ C4 (H×nh 
13.3.22 b) 

Command: Line ↵ 

Specify first point: TAN ↵ to (Chän ®−êng trßn C2 gÇn P1)  

Specify next point or [Undo]: TAN ↵ to  (Chän ®−êng trßn C4 gÇn P3)   

Specify next point or [Undo/Close]: ↵ 

Command: 

- T−¬ng tù vÏ ®o¹n P2P4. 

- VÝ dô: 2   Sö dông c¸c ph−¬ng thøc truy b¾t ®iÓm CENter, QUAdrant 

- Thùc hiÖn b¶n vÏ (H×nh 13.4.23 a) cã m« h×nh minh ho¹ (H×nh 13.4.23 b) theo 

c¸c kÝch th−íc trªn b¶n vÏ 
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          a) H×nh chiÕu b»ng       b) M« h×nh minh ho¹ 3D 

H×nh 13. 4.23 
   
1. VÏ ®−êng trßn C1 cã t©m O b¸n kÝnh R = 100 (H×nh 13.4.23 a) 

Command: Circle ↵ (hoÆc nhËp c) 

Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : (Chän ®iÓm O1 
bÊt kú lµm t©m) 

 Specify radius of circle or [Diameter] : 100↵ 

1. VÏ ®−êng trßn C1 cã t©m O b¸n kÝnh R = 100 (H×nh 13.4.23 b) 

      Command: Circle ↵ (hoÆc nhËp c) 

 Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : 2P↵ 

 First point on diameter: CEN↵ of (B¾t ®iÓm t©m O1 cña ®−êng trßn C1) 

 Second point on diameter: QUA↵ of (B¾t ®iÓm t©m Q1 cña ®−êng trßn C1) 

2. VÏ ®−êng trßn C3 ®ång t©m víi C2 cã b¸n kÝnh 30 (H×nh 13.4.23 c) 

      Command: Circle ↵ (hoÆc nhËp c) 

 Specify center point for circle or [ 3P/2P/Ttr (tan tan radius) ] : CEN↵ of (b¾t  

     ®iÓm O2) 

 First point on diameter: 30↵  

 



 63 

d)

b)

c)

a)

CEN

C2

O
2

CEN

QUA

1
Q

C2

2
O O1

1CC1

1O

 
H×nh 13.4.23. VÏ c¸c ®−êng trßn b»ng lÖnh Circle 

  

3. G¸n chÕ ®é truy b¾t th−êng tró (lÖnh Osnap) 

- G¸n chÕ ®é truy b¾t ®iÓm th−êng tró b»ng hép tho¹i Drafting setting. 
- Hép tho¹i Drafting setting cã ba trang Snap and Grid, Polar Tracking vµ Object 

Snap. Trong phÇn nµy ta chØ nghiªn cøu Object Snap 
- §Ó lµm xuÊt hiÖn hép tho¹i Drafting setting. 
+ T¹i dßng command ta nhËp Osnap vµ enter 
+ Trªn menu ta chän Tools råi chän môc Drafting setting 
- Khi ta nhËp lÖnh Osnap sÏ xuÊt hiÖn hép tho¹i (H×nh 13.4.24) sau ®ã ta chän 

môc Object Snap (H×nh 13.4.25) 

 
H×nh  13.4.24 
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H×nh 13.4.25 

- Trªn hép héi tho¹i nµy ®Ó g¸n c¸c ph−¬ng thøc truy b¾t ®iÓm th−êng tró ta 
chän c¸c « t−¬ng øng trªn khung Object Snap modes. Trªn (H×nh 13.4.25) ta chän: 
Endpoint, midpoint, Center, Quadrant, Intersection, Extend, Perpendicular. 

- C¸c danh môc lùa chän kh¸c 

+ Select All: Chän tÊt c¶ c¸c ph−¬ng thøc truy b¾t ®iÓm cã trong b¶ng 

+ Clear all  : Huû bá tÊt c¶ c¸c ph−¬ng thøc truy b¾t ®iÓm ®· chän  

+ Object Snap on (F3): T¾t më chÕ ®é truy b¾t ®iÓm th−êng tró b»ng phÝm F3 

+ Object Snap tracking On (F11): T¾t më chÕ ®é b¾t ®iÓm Tracking b»ng phÝm F11.  
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Bµi 5 

Lùa chän ®èi t−îng, hiÖu chØnh ®èi t−îng 

M· bµi: MH CG1 13 16 

I. Giíi thiÖu:   

- Bµi häc nµy gióp cho häc sinh biÕt c¸ch hiÖu chØnh ®èi t−îng b»ng c¸c ph−¬ng 
thøc lùa chän ®èi t−îng trong mét sè tr−êng hîp ta kh«ng thÓ vÏ ®èi t−îng b»ng 
c¸ch nhËp to¹ ®é ®−îc. 

II. Môc tiªu thùc hiÖn.  

- Lùa chän vµ xo¸ ®−îc c¸c ®èi t−îng ®¬n hoÆc 1 nhãm ®èi t−îng. 

- Sö dông ®−îc c¸c lÖnh hiÖu chØnh ®Ó vÏ nhanh. 

- Thay ®æi ®−îc kÝch th−íc b¶n vÏ theo mét tû lÖ cÇn thiÕt. 

III. Néi dung chÝnh: 

1. Xo¸ vµ phôc håi c¸c ®èi t−îng bÞ xo¸ 

2. Huû bá lÖnh ®· thùc hiÖn 

3. C¸c ph−¬ng ph¸p lùa chän ®èi t−îng 

4. XÐn mét phÇn ®èi t−îng n»m gi÷a hai ®èi t−îng giao 

5. XÐn mét phÇn ®èi t−îng n»m gi÷a hai ®iÓm chän 

6. VÏ nèi tiÕp hai ®èi t−îng bëi cung trßn (LÖnh Fillet) 

7. V¸t mÐp c¹nh (LÖnh Chamfer) 

8. T¹o c¸c ®èi t−îng song song (LÖnh Offset) 

9. KÐo dµi ®èi t−îng (LÖnh Extend) 

 IV.  C¸c h×nh thøc häc tËp: 

- Häc trªn líp vÒ c¸c c¸ch lùa chän ®èi t−îng. 

- Thùc hiÖn c¸c lÖnh c¾t xÐn, kÐo gi·n ®èi t−îng. 

- Thùc hiÖn lÖnh v¸t gãc c¹nh, bo trßn gãc c¹nh. 

- Gi¸o viªn thao t¸c mÈu, gi¶i dïng m¸y chiÕu Projector chiÕu lªn b¶ng yªu cÇu 
häc sinh x¸c ®Þnh to¹ ®é c¸c ®iÓm. H−íng dÉn c¸ch xo¸ c¸c ®èi t−îng ®· vÏ, c¸ch 
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lùa chän ®èi t−îng, c¾t xÐn ®èi t−îng, t¹o ®èi t−îng song song víi ®èi t−îng cã s½n, 
kÐo dµi ®èi t−îng. 

1. Xo¸ vµ phôc håi c¸c ®èi t−îng bÞ xo¸ 

- LÖnh: Erase 

- Dïng ®Ó xo¸ c¸c ®èi t−îng ®· vÏ 

- C¸ch vµo lÖnh: 3 c¸ch 

+ Trªn Menu → Modify→ Chän Erase 

+ Trªn Modify toolbar → ta chän biÓu t−îng 

+ Command: Erase↵ (HoÆc nhËp E↵) 

Command: Erase↵ 

Select objects: (Chän ®èi t−îng cÇn xo¸ ) 

Select objects: (Chän ®èi t−îng cÇn xo¸ hoÆc nhÊn Enter ®Ó kÕt thóc lÖnh) 
LÖnh oops sö dông ®Ó phôc håi l¹i c¸c ®èi t−îng ®−îc xo¸. 

2. Huû bá lÖnh ®· thùc hiÖn 

- LÖnh: Undo 

- Dïng ®Ó huû bá lÖnh ®· thùc hiÖn tr−íc ®ã 

- C¸ch vµo lÖnh: 2 c¸ch 

+ Trªn Standard toolbar → ta chän biÓu t−îng 

+ Command:Undo↵ (HoÆc nhËp U↵) 

- VÝ dô: vÏ ElÝp H×nh 13.5.1 

Command: Ellipse↵ 

Specify axis endpoint of ellipse or [Arc/Center]: 

Specify other endpoint of axis: 

Specify distance to other axis or [Rotation]: 

Command: U↵ 

ELLIPSE GROUP                                                                   H×nh 13. 5.1 

3. C¸c ph−¬ng ph¸p lùa chän ®èi t−îng 

3.1. Pickpox     

- Dïng « chän cña chuét, mçi lÇn ta chØ chän ®−îc mét ®èi t−îng. 

- T¹i dßng nh¾c ``Select object`` xuÊt hiÖn « vu«ng, ta kÐo « vu«ng nµy giao víi 
®èi t−îng cÇn chän 
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Pickbox

 
H×nh 13. 5.2 

3.2. Auto  

P1

P2 P1

P2  

 

H×nh 13. 5.3. Chän c¸c ®èi t−îng theo chÕ ®é Auto 
   
- T¹i dßng nh¾c ``Select object`` Ta chän hai ®iÓm x¸c ®Þnh khung cöa sæ.  

- NÕu ®iÓm ta chän ®Çu tiªn P1 n»m bªn tr¸i, ®iÓm thø hai P2 bªn ph¶i th× nh÷ng 
®èi t−îng nµo n»m trän trong khung cöa sæ míi ®−îc chän (T−¬ng tù kiÓu chän 
Window). 

- NÕu ®iÓm P1 n»m bªn ph¶i, ®iÓm P2 n»m bªn tr¸i th× nh÷ng ®èi t−îng n»m 
trong vµ giao víi « cöa sæ ®Òu ®−îc chän (T−¬ng tù kiÓu chän Crossing Window) 
(H×nh 13.5.3)    

3.3. Window (W) 

- Dïng khung cöa sæ ®Ó lùa chän ®èi t−îng. 

- T¹i dßng nh¾c ``Select object`` Ta nhËp W. Chän hai ®iÓm W1 vµ W2 ®Ó x¸c 
®Þnh khung cöa sæ, nh÷ng ®èi t−îng nµo n»m trän trong khung cöa sæ míi ®−îc chän 
(H×nh 13.5.4 a) 

Crossing Window (C) 

- Dïng khung cöa sæ ®Ó lùa chän ®èi t−îng. 

- T¹i dßng nh¾c ``Select object`` Ta nhËp C. Chän hai ®iÓm W1 vµ W2 ®Ó x¸c 
®Þnh khung cöa sæ, nh÷ng ®èi t−îng nµo n»m trong hoÆc giao víi khung cöa sæ ®Òu 
®−îc chän (H×nh 13.5.4b) 

a) Auto (Window) b) Auto (Crosing Window) 
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W1 W2

W2 W1

 

 

H×nh 13.5.4. Chän c¸c ®èi t−îng theo chÕ ®é Window 
    

4. XÐn mét phÇn ®èi t−îng n»m gi÷a hai ®èi t−îng giao 

- LÖnh: Trim 

- Dïng ®Ó c¾t xÐn c¸c ®èi t−îng n»m gi÷a hai ®èi t−îng giao 

- C¸ch vµo lÖnh: 2 c¸ch 

+  Trªn Draw toolbar → ta chän biÓu t−îng 

+ Command: Trim↵ (HoÆc nhËpTr↵) 

Command: Trim↵ 

Current settings: Projection=UCS Edge=None 

Select cutting edges ... 

Select objects: (Chän ®èi t−îng giao víi ®o¹n mµ ta muèn xÐn, H×nh 13.5.5 c¸c 
®èi t−îng cã d¹ng ®−êng khuÊt) 

Select objects: (Chän c¸c ®èi t−îng ®Þnh ®èi t−îng cÇn c¾t hoÆc NhÊn Enter ®Ó 
kÕt thóc lùa chän) 

Select object to trim or [Project/Edge/Undo]: (Chän ®èi t−îng cÇn xÐn, h×nh 4.5 
lµ c¸c ®o¹n cã dÊu €) 

Select object to trim or [Project/Edge/Undo]:(TiÕp tôc chän ®èi t−îng cÇn xÐn 
hoÆc nhÊn Enter ®Ó kÕt thóc lÖnh) 

a) Window b) Crosing Window 
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H×nh 13.5.5. XÐn c¸c ®èi t−îng b»ng lÖnh Trim 

Chó ý: 

T¹i dßng nh¾c ``Select object`` nÕu muèn chän tÊt c¶ c¸c ®èi t−îng lµm ®èi 
t−îng giao ta chØ cÇn nhÊn phÝm Enter (H×nh 13.5.5 b),  

C¸c lùa chän kh¸c 

Edgemode: Cho phÐp chän cutting Edges lµ ®èi t−îng chØ giao víi ®èi kh¸c khi 
kÐo dµi (Extend hoÆc NoExtend) (H×nh 13.5.6) 

 

 

Object to trim (§èi t−îng xÐn) 

Cutting Edge (§èi t−îng giao) 

a) Cutting edge chän t¹i dßng nh¾c ``Select object`` 

b) T¹i dßng nh¾c ``Select object`` nhÊn phÝm Enter 

Object to Trim (§o¹n cÇn xÐn) 

a) Thùc hiÖn lÖnh Trim  b) Sau khi thùc hiÖn lÖnh Trim  

Cutting Edge 

H×nh 13.5.6. Trim víi Edgemode = Extend 
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Command: Trim↵ 

Current settings: Projection=UCS Edge=None 

Select cutting edges ... 

Select objects: (Chän ®èi t−îng giao víi ®o¹n mµ ta muèn xÐn) 

Select objects: (Chän tiÕp c¸c ®èi t−îng giao víi ®o¹n mµ ta muèn xÐn hoÆc 
nhÊn enter ®Ó kÕt thóc viÖc lùa chän) 

Select object to trim or [Project/Edge/Undo]: E↵ 

Enter an implied edge extension mode [Extend/No extend] <No extend>: E↵ 

Select object to trim or [Project/Edge/Undo]: (Chän ®èi t−îng xÐn) 

Select object to trim or [Project/Edge/Undo]: (Chän tiÕp ®èi t−îng xÐn hoÆc 
nhÊn enter ®Ó kÕt thóc lÖnh) 

Projectmode     Dïng lùa chän nµy ®Ó xÐn c¸c c¹nh m« h×nh khung d©y 3 chiÒu (Mo 
h×nh d¹ng khung d©y – Wireframe) 

View      Lùa chän view Cho phÐp xÐn mét ®o¹n bÊt kú cña m« h×nh 3 chiÒu lªn mÆt 
ph¼ng song song víi mµn h×nh mÆc dï thùc tÕ c¸c ®èi t−îng giao vµ c¸c ®èi 
t−îng xÐn kh«ng giao nhau (H×nh 13.5.7) 

 

 

H×nh 13. 5.7. Trim víi Projecmode 
   
Command: Trim↵ 

Current settings: Projection=View Edge=Extend 

Select cutting edges ... 

Select objects: 1 found (Chän ®o¹n th¼ng L1: §o¹n L1 ®−îc chän) 

Cutting Edges 

Object to Trim 
a) Tr−íc khi Trim b) Sau khi Trim 
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Select objects: 1 found, 2 total (Chän ®o¹n th¼ng L2: §o¹n L2 ®−îc chän, tæng 
céng cã 2 ®o¹n ®−îc chän) ( H×nh 13.5.8 a) 

Select objects: ↵ 

Select object to trim or [Project/Edge/Undo]: (Chän ®−êng C1 t¹i dÊu €) 

Select object to trim or [Project/Edge/Undo]: (Chän ®−êng C2 t¹i dÊu €) 

Select object to trim or [Project/Edge/Undo]: ↵ 

Command: 

Ta ®−îc (H×nh 13.5.8 b) 
   

Ø60

Ø30 Ø60

Ø100

L2

L1

C2

C1

120

a) b)
 

  
 H×nh 13.5.8. T¹o h×nh b»ng lÖnh Trim 

    

5. XÐn mét phÇn ®èi t−îng n»m gi÷a hai ®iÓm chän 

- LÖnh: Break 

- Dïng ®Ó c¾t xÐn mét phÇn ®èi t−îng Arc, Line, Circle, Pline. (H×nh 13. 5.9). 

- C¸ch vµo lÖnh: 2 c¸ch 

+ Trªn Modify toolbar → ta chän biÓu t−îng  

+ Command:Break↵ (HoÆc nhËp BR ↵) 

+ Command: Break↵ 

  5.1. Chän hai ®iÓm (2 points) 
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P1 P2

P2P1

P2P1

P1

P2

P2

P1

P2P1

P1

P2

P2

P1

 

 

H×nh 13.5.9. Chän hai ®iÓm khi xÐn ®èi t−îng b»ng lÖnh Break  
     
C¸c b−íc thùc hiÖn lÖnh Break 

1. Chän ®èi t−îng t¹i mét ®iÓm vµ ®iÓm nµy lµ ®iÓm ®Çu tiªn cña ®o¹n cÇn xÐn 

2. Chän ®iÓm cuèi cña ®o¹n cÇn xÐn (§iÓm thuéc ®èi t−îng hoÆc kh«ng thuéc 
®èi t−îng) 

Command: Break↵ 

Select object: (Chän ®èi t−îng cã ®o¹n mµ ta muèn xÐn vµ ®iÓm nµy lµ ®iÓm ®Çu 
tiªn cña ®o¹n cÇn xÐn, vÝ dô: ®iÓm P1)(H×nh 13. 4.9) 

Specify second break point or [First point]: (Chän ®iÓm cuèi cña ®o¹n cÇn xÐn 
vµ ®iÓm nµy lµ ®iÓm thø hai cña ®o¹n cÇn xÐn, vÝ dô: ®iÓm P2) (H×nh 13.5.9) 

5.2. Chän ®èi t−îng vµ hai ®iÓm (2 point Select) 

- Theo ph−¬ng ph¸p nµy ngoµi viÖc chän ®èi t−îng ta cßn ph¶i chän hai ®iÓm 
®Çu vµ cuèi cña ®o¹n cÇn xÐn. (H×nh 13.5.10) 

a) XÐn Line vµ Arc cã ®iÓm chÌn thuéc 
®èi t−îng 

b) XÐn Line cã ®iÓm chÌn kh«ng 
thuéc ®èi t−îng 

c) XÐn Circle cã ®iÓm chÌn thuéc 
®èi t−îng 

d) XÐn Arc cã ®iÓm chÌn kh«ng thuéc 
 ®èi t−îng 
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P2P1 P3

P1 P2 P3

 

P1

P2

P3

 

 
  
 
   

H×nh 13. 5.10. Chän ®èi t−îng vµ hai ®iÓm b»ng lÖnh Break 

Thùc hiÖn 

Command: Break↵ 

Select object: (Chän ®èi t−îng cã ®o¹n mµ ta muèn xÐn, vÝ dô: chän ®èi t−îng 
t¹i ®iÓm P1( H×nh 13.5.10)) 

Specify second break point or [First point]: F↵ 

Specify first break point: (Chän ®iÓm ®Çu tiªn cña ®o¹n cÇn xÐn, vÝ dô: ®iÓm P2) 
(H×nh 13.510) 

Specify second break point: (Chän ®iÓm cuèi cña ®o¹n cÇn xÐn, vÝ dô: ®iÓm P3) 
(H×nh 13.5.10) 

6.  VÏ nèi tiÕp hai ®èi t−îng bëi cung trßn (LÖnh Fillet) 

- LÖnh: Fillet 

- Dïng ®Ó vÏ nèi tiÕp hai ®èi t−îng bëi mét cung trßn (H×nh 13.5.11) 

- C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Fillet 

+ Trªn Modify toolbar → ta chän biÓu t−îng    

Select 

Select 

a) Tr−íc khi thùc hiÖn 
lÖnh Break 

b) Sau khi thùc hiÖn lÖnh 
Break 
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+ Command:Fillet↵ (HoÆc nhËp F↵) 

C¸c b−íc thùc hiÖn 

B−íc 1: X¸c ®Þnh b¸n kÝnh cung nèi tiÕp R (Gi¸ trÞ b¸n kÝnh nµy trë thµnh mÆc 
®Þnh) 

B−íc 2: Ta chän ®èi t−îng ®Ó thùc hiÖn lÖnh Fillet 

 

1

2

 

2

2

2

2

2

2

2

1

1

1

1

1

1

1
 

H×nh 13.5.11. Fillet víi b¸n kÝnh R > 0 

Tr−íc Fillet Sau Fillet 

b) Line vµ Arc 

c) Hai Arc 

d) Hai Circle 

a) Hai Line 
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Command: Fillet↵ 

Current settings: Mode = TRIM, Radius = 10.0000 

Select first object or [Polyline/Radius/Trim]: R↵ (NhËp R ®Ó chän b¸n kÝnh 
Fillet) 

Specify fillet radius <10.0000>:(NhËp gi¸ trÞ b¸n kÝnh R) 

C¸c lùa chän kh¸c 

  Polyline    

- NÕu ta chØ Fillet hai ph©n ®o¹n cña mét ®a tuyÕn th× sau khi ®Þnh b¸n kÝnh R ta 
chän hai ph©n ®o¹n kÕ tiÕp cña ®a tuyÕn nh− hai ®èi t−îng ®¬n.  

- NÕu muèn Fillet toµn bé c¸c ®Ønh ®a tuyÕn thi sau khi nhËp R ta thùc hiÖn nh− 
sau (H×nh 13. 4.12) 

Command: fillet↵ 

Current settings: Mode = NOTRIM, Radius = 30.0000 

Select first object or [Polyline/Radius/Trim]: P↵ 

Select 2D polyline: (Chän Polyline cÇn bo trßn c¸c ®Ønh (H×nh 13.5.12)) 

 

 

 
H×nh 13.5.12. §èi t−îng Fillet lµ ®a tuyÕn 

Trim/NoTrim    

- Thùc hiÖn lÖnh Fillet ®ang ë tr¹ng th¸i Trim mode (MÆc ®Þnh) th× c¸c ®èi 
t−îng ®−îc chän ®Ó Fillet sÏ kÐo dµi ®Õn hoÆc xÐn c¸c ®o¹n thõa t¹i c¸c ®iÓm giao 
hoÆc tiÕp xóc. 

- NÕu chän NoTrim mode th× c¸c ®èi t−îng sÏ kh«ng ®−îc kÐo dµi hoÆc xÐn ®i 
t¹i c¸c ®iÓm tiÕp xóc víi cung nèi. (H×nh 13.5.13) 

Tr−íc Fillet Sau Fillet 

Polyline 
Polyline 
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Command:FILLET 

Current settings: Mode = TRIM, Radius = 30.0000 

Select first object or [Polyline/Radius/Trim]: T (§¸p T chän Trim mode) 

Enter Trim mode option [Trim/No trim] <Trim>: N (§¸p N chän NoTrim mode) 

Select first object or [Polyline/Radius/Trim]: P 

Select 2D polyline: Select 2D polyline: 

4 lines were filleted 

Fillet Radius

Pline

 

First Object

Second Object

Fillet Radius

 

 

H×nh 13.5.13. Fillet víi chÕ ®é Notrim mode 
 

7. V¸t mÐp c¹nh (LÖnh Chamfer) 

- LÖnh: Chamfer 

- Dïng ®Ó t¹o ®−êng xiªn t¹i ®iÓm giao nhau cña hai ®o¹n th¼ng hoÆc t¹i c¸c 
®Ønh cña ®a tuyÕn cã hai ph©n ®o¹n (Segment) lµ c¸c ®o¹n th¼ng. (H×nh 13.5.14) 

- C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Chamfer 

+ Trªn Modify toolbar → ta chän biÓu t−îng    

+ Command:Chamfer↵  

C¸c b−íc thùc hiÖn 

B−íc 1: X¸c ®Þnh kho¶ng c¸ch cÇn v¸t trªn mçi c¹nh hoÆc gi¸ trÞ kho¶ng c¸ch 
cña mét c¹nh vµ gãc nghiªng (Gi¸ trÞ kho¶ng c¸ch nµy trë thµnh mÆc ®Þnh). 

a) Tr−íc Fillet 
b) Sau Fillet 

a) Tr−íc Fillet b) Sau Fillet 
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B−íc 2: Ta chän ®èi t−îng ®Ó thùc hiÖn lÖnh Chamfer 

Command: Chamfer↵ 
(NOTRIM mode) Current chamfer Dist1 = 10.0000, Dist2 = 10.0000 
Select first line or [Polyline/Distance/Angle/Trim/Method]: 
C¸c lùa chän kh¸c 

 Method     

- Chän mét trong hai ph−¬ng ph¸p chän ®−êng v¸t mÐp. Distance (NhËp gi¸ trÞ 
hai kho¶ng c¸ch), Angle (NhËp gi¸ trÞ mét kho¶ng c¸ch vµ mét gãc)  

Distance  - Dïng lùa chän nµy ®Ó nhËp hai kho¶ng c¸ch. Sau ®ã lËp l¹i lÖnh ®Ó 
chän hai c¹nh cÇn chamfer (H×nh 13.5.14) 

Command: Chamfer↵ 
(NOTRIM mode) Current chamfer Dist1 = 10.0000, Dist2 = 10.0000 
Select first line or [Polyline/Distance/Angle/Trim/Method]: D↵ 
Specify first chamfer distance <10.0000>: (NhËp gi¸ trÞ kho¶ng c¸ch thø nhÊt) 
Specify second chamfer distance <10.0000>:(NhËp gi¸ trÞ kho¶ng c¸ch thø hai) 
- §Ó thùc hiÖn lÖnh v¸t mÐp ta thùc hiÖn l¹i lÖnh chamfer mét lÇn n÷a 

Command: Chamfer↵ 
(NOTRIM mode) Current chamfer Dist1 = 10.0000, Dist2 = 10.0000 
Select first line or [Polyline/Distance/Angle/Trim/Method]: D↵ 
Specify first chamfer distance <10.0000>: (Chän ®o¹n th¼ng thø nhÊt) 
Specify second chamfer distance <10.0000>: (Chän ®o¹n th¼ng thø hai) 

First chamfer distance Second distance
1

2

2

1
First chamfer distance

Angle from the first line

 

 

H×nh 13.5.14. LÖnh Chamfer víi lùa chän Distance vµ Angle 

a) Distance b) Angle 

Tr−íc chamfer 

Sau chamfer Tr−íc chamfer 

Sau chamfer 
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Angle   Lùa chän nµy cho phÐp nhËp gi¸ trÞ kho¶ng c¸ch thø nhÊt vµ gãc cña 
®−êng v¸t mÐp hîp víi ®−êng thø nhÊt (H×nh 13.5.14 b)  

Command: CHAMFER↵ 

(NOTRIM mode) Current chamfer Dist1 = ..., Dist2 = ... 

Select first line or [Polyline/Distance/Angle/Trim/Method]: A↵ 

Specify chamfer length on the first line <>: (NhËp gi¸ trÞ kho¶ng c¸ch v¸t mÐp 
trªn ®−êng thø nhÊt) 

Specify chamfer angle from the first line <>: (NhËp gi¸ trÞ gãc gi÷a ®−êng v¸t 
mÐp hîp víi ®−êng thø nhÊt)  

Trim/Notrim  Chøc n¨ng nµy t−¬ng tù nh− tr×nh bµy ë lÖnh Fillet 

Polyline  Chøc n¨ng nµy t−¬ng tù nh− tr×nh bµy ë lÖnh Fillet (H×nh 13.5.15) 

 
  

H×nh 13.5.15. Chän Chamfer Polyline 
   

8. T¹o c¸c ®èi t−îng song song (LÖnh Offset) 

- LÖnh: Offset  

- Dïng ®Ó t¹o c¸c ®èi t−îng míi song song theo h−íng vu«ng gãc víi c¸c ®èi 
t−îng ®−îc chän.  

- §èi t−îng ®−îc chän ®Ó t¹o c¸c ®èi t−îng song song cã thÓ lµ Line, Circle, 
Arc, pline, Spline ... (H×nh 13.5.16) 

- C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Offset 

+ Trªn Modify toolbar → ta chän biÓu t−îng 

+ Command:Offset↵ (HoÆc NhËp O ↵) 

 

    Polyline 
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H×nh 13.5.16. Lùa chän Distance vµ h−íng t¹o ®èi t−îng cña lÖnh Offset 

C¸c b−íc thùc hiÖn 

B−íc 1: NhËp kho¶ng c¸ch gi÷a c¸c ®èi t−îng song song (Offset distance) 

B−íc 2: Chän h−íng t¹o ®èi t−îng míi ``Side to Offset``  (H×nh 13.5.16) 

Command: Offset↵ 

Specify offset distance or [Through] <Through>: (NhËp gi¸ trÞ kho¶ng c¸ch 
gi÷a hai ®èi t−îng song song) 

Select object to offset or <exit>: (Chän ®èi t−îng 1 ®Ó t¹o ®èi t−îng song song 
víi nã) 

Specify point on side to offset: (Chän mét ®iÓm ®Ó chän phÝa ®èi t−îng míi song 
song so víi ®èi t−îng chän) 

Select object to offset or <exit>: (TiÕp tôc chän ®èi t−îng cÇn t¹o ®èi t−îng míi 
hoÆc nhÊn enter ®Ó kÕt lÖnh) 

9. KÐo dµi ®èi t−îng (LÖnh Extend) 

- LÖnh: Extend 

- Dïng ®Ó kÐo dµi mét ®èi t−îng (Object to extend) ®Õn giao víi mét ®èi t−îng 
®−îc chän (gäi lµ c¹nh biªn Boundary edge(s)) míi song song theo h−íng vu«ng gãc 
víi c¸c ®èi t−îng ®−îc chän.  (H×nh 13.5.17) 

- C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Extend 

+ Trªn Modify toolbar → ta chän biÓu t−îng   

+ Command: Extend ↵ (HoÆc NhËp Ex ↵) 
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Command: EXTEND↵ 

Current settings: Projection=View Edge=Extend 

Select boundary edges ... 

Select objects: (Chän ®èi t−îng lµm ®−êng biªn ®Õn hoÆc nhÊn enter ®Ó chän tÊt 
c¶ c¸c ®èi t−îng trªn b¶n vÏ lµm ®−êng biªn) 

Select objects: (Chän tiÕp ®èi t−îng lµm ®−êng biªn ®Õn hoÆc nhÊn enter kÕt 
thóc lÖnh) 

Select object to extend or [Project/Edge/Undo]: (Chän ®èi t−îng cÇn kÐo dµi) 

Select object to extend or [Project/Edge/Undo]: (Chän tiÕp c¸c ®èi t−îng cÇn 
kÐo dµi hoÆc nhÊn Enter ®Ó kÕt thóc lÖnh) 

  

 

 
H×nh 13.5.17. Sö dông lÖnh Extend kÐo dµi mét ®èi t−îng. 

  
C¸c lùa chän kh¸c 

Edgemode/Projectmode   

 - T−¬ng tù lÖnh Trim. Sö dông lùa chän Edgemode cña lÖnh Extend ®Ó kÐo dµi 
mét ®o¹n th¼ng ®Õn mét ®o¹n th¼ng kh«ng giao víi nã. (H×nh 13.5.18) 

Command: _extend↵ 

Current settings: Projection=View Edge=Extend 

Select boundary edges ... 

Select objects: (Chän ®èi t−îng cÇn kÐo ®Õn Boundary) 

Select object to extend or [Project/Edge/Undo]: E↵ 

§èi t−îng cÇn kÐo dµi 

(Object to Extend) 
C¹nh biªn (Boundary Edge) 

§èi t−îng cÇn kÐo dµi 

(Object to Extend) 

§èi t−îng cÇn kÐo dµi 

(Object to Extend) C¹nh biªn 
(Boundary Edge)  

C¹nh biªn (Boundary Edge) 
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Enter an implied edge extension mode [Extend/No extend] <Extend>: E↵ 

Select object to extend or [Project/Edge/Undo]: (Chän tiÕp c¸c ®èi t−îng cÇn 
kÐo dµi hoÆc nhÊn Enter ®Ó kÕt thóc lÖnh) 

Line to Extend

Boundary Edge

 

 

H×nh 13.5.18. Extend víi chÕ ®é Edgemode 

VÝ dô: 

1. Sö dông c¸c lÖnh theo tr×nh tù ®Ó vÏ (H×nh 13.5.19 h) 

 

                                            H×nh 13.5.19 

 

a) Tr−íc Extend b) Sau Extend 
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2. VÏ h×nh 13.5.20 theo tr×nh tù (a-f) 

a) Rectang b) Ellipse
 

c) O ffset
d) L ine

 

 
H×nh 13.5.20 

   

10. Bµi tËp 

1. Sö dông c¸c lÖnh ®· häc vÏ c¸c h×nh (H×nh 13.5.21) 
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H×nh 13. 5.21 

2. Sö dông c¸c lÖnh ®· häc (Line, Circle, Offset, Fillet vµ Trim vÏ c¸c h×nh 
(H×nh 13.5.22) 

 



 84 

 
H×nh 13.5.22 
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Bµi 6 

C¸c lÖnh vÏ nhanh 

M· bµi: MH CG1 13 18 

I. Giíi thiÖu:   

- Bµi häc nµy gióp cho häc sinh biÕt c¸ch hiÖu chØnh ®èi t−îng b»ng c¸c ph−¬ng 
thøc lùa chän ®èi t−îng trong mét sè tr−êng hîp ta kh«ng thÓ vÏ ®èi t−îng b»ng 
c¸ch nhËp to¹ ®é ®−îc. 

II. Môc tiªu thùc hiÖn.  

- LiÖt kª ®−îc c¸c lÖnh vÏ nhanh ®Ó t¹o c¸c ®èi t−îng vÏ míi gièng víi ®èi 
t−îng ®· cã trªn vïng ®å ho¹ (vïng vÏ). 

- T¹o ®−îc c¸c ®èi t−îng míi theo d·y, theo hµng hoÆc theo 1 cung trßn hoÆc 1 
vßng trßn  

- Sö dông thµnh th¹o c¸c lÖnh vÏ nhanh. 

II. Néi dung chÝnh: 

1. PhÐp dêi h×nh 

2. PhÐp ®èi xøng qua trôc 

3. Quay chung quanh mét ®iÓm 

4. PhÐp biÕn ®æi tû lÖ 

5. KÐo gi·n ®èi t−îng 

6. Sao chÐp h×nh 

7. Sao chÐp d·y 

IV. C¸c h×nh thøc häc tËp: 

- Häc trªn líp vÒ c¸c c¸ch di chuyÓn c¸c ®èi t−îng. 

- T¹o ®èi t−îng míi theo phÐp ®èi xøng, quay chung quanh mét ®iÓm, sao chÐp 
h×nh theo d·y, theo mét vßng trßn. 

- Gi¸o viªn lµm vÝ dô mÈu vµ dïng m¸y chiÕu Projector chiÕu lªn b¶ng ®Ó häc 
sinh theo dâi t×nh tù thùc hiÖn c¸c phÐp biÕn ®æi, t¹o h×nh. 
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1. PhÐp dêi h×nh 

- LÖnh: Move 

- Dïng ®Ó thùc hiÖn phÐp dêi mét hay nhiÒu ®èi t−îng tõ vÞ trÝ hiÖn t¹i ®Õn mét 
vÞ trÝ bÊt kú trªn h×nh vÏ (H×nh 13. 6.1) 

- C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Move 

+ Trªn Modify toolbar → ta chän biÓu t−îng 

+ Command: Move ↵ (HoÆc NhËp M↵) 

Command: MOVE↵ 

Select objects: (Chän c¸c ®èi t−îng cÇn dêi) 

Select objects: (TiÕp tôc chän c¸c ®èi t−îng cÇn dêi hoÆc nhÊn Enter ®Ó kÕt thóc 
viÖc lùa chän ®èi t−îng) 

Specify base point or displacement: (Chän ®iÓm chuÈn hay nhËp kho¶ng dêi) 

Specify second point of displacement or <use first point as displacement>: 
(Chän ®iÓm c¸c ®èi t−îng dêi ®Õn) 

 

M
ov
e

Second point

Base point

Base point

Second point

M
ov
e

 

 

H×nh 13.6.1.  Dêi h×nh víi lÖnh Move) 

Chó ý: 

1. §iÓm Base point vµ second point of displacement cã thÓ chän bÊt kú (H×nh 
13. 6.1a) 

a) Chän ®iÓm bÊt kú b) Truy b¾t ®iÓm  
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2. Muèn dêi ®èi t−îng cÇn vÞ trÝ chÝnh x¸c th× t¹i Base point vµ second point of 
displacement ta dïng c¸c ph−¬ng thøc truy b¾t ®iÓm (VÝ dô: H×nh 6.1 b) 

3. §iÓm Base point chän bÊt kú vµ second point of displacement dïng to¹ ®é 
t−¬ng ®èi hoÆc cùc t−¬ng ®èi ®Ó dêi c¸c ®èi t−îng (VÝ dô: H×nh 6.2 a Dêi 
h×nh Tivi ®i mét kho¶ng c¸ch 150 vµ theo gãc 60) 

4. T¹i dßng nh¾c ‘’Base point  or displacement’’ ta cã thÓ nhËp kho¶ng dêi theo 
to¹ ®é X vµ Y, khi ®ã t¹i dßng nh¾c tiÕp theo ta nhÊn Enter (VÝ dô: H×nh 6.2 b 
dêi ®èi t−îng theo trôc X 170 ®¬n vÞ theo trôc Y 140 ®¬n vÞ) 

Base point

 

 
H×nh 13. 6.2 

Command: MOVE↵ (H×nh 13. 6.2 b) 

Select objects: (Chän c¸c ®èi t−îng cÇn dêi) 

Select objects: (NhÊn Enter ®Ó kÕt thóc viÖc lùa chän ®èi t−îng) 

Specify base point or displacement: 170,140↵ 

Specify second point of displacement or <use first point as displacement>:↵  

2. PhÐp ®èi xøng qua trôc 

 - LÖnh: Mirror 

- Dïng ®Ó t¹o c¸c ®èi t−îng míi ®èi xøng víi c¸c ®èi t−îng ®−îc chän qua mét 
trôc (H×nh 13. 6.3)  

- C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Mirror 

+ Trªn Modify toolbar → ta chän biÓu t−îng    

+ Command: Mirror ↵ (HoÆc NhËp M↵) 

a) Polar  b) NhËp kho¶ng dêi X, Y 
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d) Delecte old objects? ''Y''c) Delecte old objects? ''N''

b) After mirror

Crossing window

a) Before mirror

W2
Second point of mirror line

Mirror line

First point of mirror line

P2

W1

P1

 
   

H×nh 13. 6.3. PhÐp ®èi xøng qua trôc  
    
Command: Mirror↵ 

Select objects: (Lùa chän c¸c ®èi t−îng ®Ó thùc hiÖn phÐp ®èi xøng) 

Select objects: (Chän tiÕp c¸c ®èi t−îng hoÆc nhÊn Enter ®Ó kÕt thóc viÖc lùa 
chän) 

Specify first point of mirror line: (Chän ®iÓm thø nhÊt cña trôc ®èi xøng) 

Specify second point of mirror line: (Chän ®iÓm thø hai cña trôc ®èi xøng) 

Delete source objects? [Yes/No] <N>: (Xo¸ ®èi t−îng chän hay kh«ng? MÆc 
®Þnh kh«ng ‘’No’’, nÕu xo¸ ®èi t−îng chän th× ta nhËp ‘’Y’’) 

Khi lÊy ®èi xøng c¸c dßng ch÷ bÞ ng−îc, nÕu muèn kh«ng bÞ ng−îc ta dïng lÖnh 
setvar g¸n biÕn Mirrtext = 0 (H×nh 13. 6.4) 
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+12 V

c) Before Mirror

10k

R3

+12 V

a) Before Mirror

10k

R3

+12 V

d) After Mirror (BiÕn Mirrtext=0)

10k

R3

b) After Mirror (BiÕn Mirrtext=1)

  

H×nh 13. 6.4. ¶nh h−ëng biÕn Mirrtext khi thùc hiÖn lÖnh Mirror 

VÝ dô:  

Sö dông lÖnh Mirror ®Ó t¹o h×nh h×nh häc (H×nh 13. 6.5) 

Crossing Window

Pick Object

W2

W2

c)

Mirror line

W1

a) b)
Crossing Window

Mirror line
Mirror line

W1

d)  
H×nh 13. 6.5. Sö dông lÖnh Mirror t¹o b¶n vÏ 
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3. Quay chung quanh mét ®iÓm 

LÖnh: Rotate 

- Dïng ®Ó quay c¸c ®èi t−îng ®−îc chän chung quanh mét ®iÓm chuÈn (Base 
point) gäi lµ t©m quay (H×nh 13. 6.6)  

- C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Rotate 

+ Trªn Draw toolbar → ta chän biÓu t−îng   

+ Command: Rotate ↵ (HoÆc NhËp Ro↵) 

Command line: Rotate ↵ 

Current positive angle in UCS:  ANGDIR=current  ANGBASE=current  

Select objects:  (Chän ®èi t−îng cÇn quay) 

Select objects: (Ên Enter khi kÕt thóc) 

Specify base point:  (Chän mét t©m quay)  

Specify rotation angle or [Reference]:  (NhËp gi¸ trÞ gãc quay hoÆc ®¸p R ®Ó 
nhËp gãc tham chiÕu) 

Select object

W1

W2

Rotate Object

Rotation Angle

 
(H×nh 13. 6.6. Sö dông lÖnh Rotate ®Ó quay ®èi t−îng 

Lùa chän: 

Reference 

- NÕu ®¸p R t¹i dßng nh¾c xuÊt hiÖn 

Specify the reference angle <0>: (Gãc tham chiÕu)  

Specify the new angle: (NhËp gi¸ trÞ gãc míi)   

VÝ dô 1 

Quay h×nh ch÷ nhËt cã ph−¬ng bÊt kú thµnh h×nh n»m ngang theo tr×nh tù sau: 
(H×nh 13. 6.7) 

Command: Rotate↵  
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Current positive angle in UCS:  ANGDIR=counterclockwise  ANGBASE=0 

Select objects: (Chän ®èi t−îng) 

Sect objects: (NhÊn Enter ®Ó kÕt thóc) 

Specify base point: (Chän mét ®iÓm bÊt kú) 

Specify rotation angle or [Reference]: R↵ 

Specify the reference angle <0>: (Truy b¾t ®iÓm P1) 

 Specify second point: (Truy b¾t ®iÓm P2) 

Specify the new angle: 0↵ 

Base point

P1

P2

 

 

H×nh 13. 6.7. Sö dông lÖnh Rotate víi lùa chän Reference 

VÝ dô: 2 

Quay ghÕ sao cho mÆt ghÕ h−íng vµo t©m ®−êng trßn theo tr×nh tù sau: (H×nh 
13. 5.8) 

 

C CC

A

B

 

 
H×nh 13. 6.8. Quay ghÕ b»ng lÖnh Rotate 

a) Tr−íc khi quay b) Sau khi quay víi gãc quay b»ng 0 

a) Tr−íc Rotate b) C¸c lùa chän  c) Sau khi Rotate  
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Command: Move↵ 

Current positive angle in UCS:  ANGDIR=counterclockwise  ANGBASE=0 

Select objects: (Chän ®èi t−îng) 

Select objects: ↵ 

Specify base point: (Chän gèc quay ®iÓm B) 

Specify rotation angle or [Reference]: R↵ 

Specify the reference angle <0>: (Truy b¾t ®iÓm B) 

Specify second point: (Truy b¾t ®iÓm A) 

Specify the new angle:  (Truy b¾t ®iÓm C) 

Ta ®−îc kÕt kÕt qu¶ nh− (H×nh 13. 6.8) 

4.  PhÐp biÕn ®æi tû lÖ 

- LÖnh: Scale 

- Dïng ®Ó t¨ng hoÆc gi¶m kÝch th−íc c¸c ®èi t−îng trªn b¶n vÏ theo mét tû lÖ 
nhÊt ®Þnh (PhÐp biÕn ®æi tû lÖ) (H×nh 13. 6.9)  

- C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Scale 

+ Trªn Modify toolbar → ta chän biÓu t−îng    

+ Command: Scale ↵ (HoÆc NhËp SC ↵) 
   

Base point Base point

Træåïc khi Scale

B

C

A

Sau khi Scale

 

 

 

H×nh 13. 6.9. Thay ®æi Scale h×nh ch÷ nhËt 

b) Scale facter = 0.5 c) Reference: truy b¾t lÇn 
l−ît B, A vµ C   

a) Scale facter = 2 
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Command: Scale↵ 

Select objects: (Chän ®èi t−îng cÇn thay ®æi tû lÖ) 

Select objects: (Chän tiÕp ®èi t−îng hoÆc Enter ®Ó kÕt thóc viÖc lùa chän) 

Specify base point: (Chän ®iÓm chuÈn lµ ®iÓm ®øng yªn khi thay ®æi tû lÖ) 

Specify scale factor or [Reference]: (NhËp hÖ sè tû lÖ hay nhËp R) 

Lùa chän  

Reference: 

- NÕu ®¸p R t¹i dßng nh¾c Specify scale factor or [Reference]: th× t¹i dßng nh¾c 
sÏ xuÊt hiÖn dßng yªu cÇu tiÕp theo. (H×nh 13. 6.10) 

Base point Base point

Træåïc khi Scale

B

C

A

Sau khi Scale

 
   

H×nh 13. 6.10. Thay ®æi Scale h×nh ch÷ nhËt 
  
Command: Scale↵ 

Select objects: (Chän c¸c ®èi t−îng cÇn scale) 

Select objects: (Chän tiÕp c¸c ®èi t−îng hoÆc nhÊn Enter ®Ó kÕt thóc lùa chän) 

Specify base point: (Chän ®iÓm chuÈn lµ ®iÓm ®øng yªn khi thay ®æi tû lÖ) 

Specify scale factor or [Reference]: R↵ 

Specify reference length <1>: (NhËp gi¸ trÞ chiÒu dµi tham chiÕu) 

Specify new length: (NhËp chiÒu dµi míi hoÆc truy b¾t ®iÓm) 
 

5. KÐo gi·n ®èi t−îng 

LÖnh: Stretch 

- Dïng ®Ó dêi vµ kÐo gi·n c¸c ®èi t−îng khi kÐo vÉn duy tr× sù dÝnh nèi c¸c ®èi 
t−îng (H×nh 13. 6.11)  

- Khi lùa chän c¸c ®èi t−îng ta dïng ph−¬ng thøc truy b¾t Crossing window 
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C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Stretch 

+ Trªn Draw toolbar → ta chän biÓu t−îng   

+ Command: Stretch ↵ (HoÆc NhËp S ↵) 

Command: Stretch↵ 
Select objects to stretch by crossing-window or crossing-polygon... 
Select objects: (Chän ®èi t−îng theo ph−¬ng thøc Crossing Window) 

Select objects: (Chän tiÕp c¸c ®èi t−îng hoÆc nhÊn Enter ®Ó kÕt thóc lùa chän) 
Specify base point or displacement: (Chän ®iÓm chuÈn hay kho¶ng dêi, t−¬ng tù 

lÖnh Move) 
Specify second point of displacement: (Chän ®iÓm dêi ®Õn, nÕu nhËp kho¶ng dêi 

th× nhÊn Enter)  

 

H×nh 13.6.11. øng dông lÖnh Stratch biÕn ®æi h×nh 
 
- Tuú vµo c¸c ®èi t−îng ®−îc chän cã c¸c tr−êng hîp sau:  
1. C¸c ®o¹n th¼ng giao víi khung cöa sæ chän ®−îc kÐo gi·n ra hoÆc co l¹i, n÷a 

®−êng trßn ®−îc dêi ®i (H×nh 13.6.11) 

 
H×nh 13. 6.12. Dêi vµ kÐo gi'n c¸c ®èi t−îng b»ng lÖnh Stratch 

Tr−íc Stratch 

Tr−íc Stratch 
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2. Cung trßn ®−îc kÐo gi·n vµ ®o¹n th¼ng bÞ co l¹i (H×nh 13. 6.13) 

30
20

5
0

R15

30 30

W2

Crosing Window

W1

R80

5
0

 
H×nh 13. 6.13. Thay ®æi b¸n kÝnh cung trßn  b»ng lÖnh Stratch 

6.  Sao chÐp h×nh 

LÖnh: Copy 
- Dïng ®Ó sao chÐp c¸c ®èi t−îng ®−îc chän theo ph−¬ng tÞnh tiÕn vµ s¾p xÕp 

chóng theo c¸c vÞ trÝ x¸c ®Þnh. Thùc hiÖn gièng lÖnh Move  
C¸ch vµo lÖnh: 3 c¸ch 
+ Menu → Modify → Copy 

+ Trªn Modify toolbar → ta chän biÓu t−îng   

+ Command: Copy ↵ (HoÆc NhËp C ↵) 

Command: Copy↵ 
Select objects: (Chän ®èi t−îng cÇn sao chÐp) 
Select objects: (Chän tiÕp c¸c ®èi t−îng hoÆc nhÊn Enter ®Ó kÕt thóc lùa chän) 
Specify base point or displacement, or [Multiple]: (Chän ®iÓm chuÈn hay nhËp 

kho¶ng dêi) 
Specify second point of displacement or <use first point as displacement>: 

(Chän ®iÓm c¸c ®èi t−îng sÏ copy ®Õn) 
Chó ý: 
1. Cã thÓ chän Base point vµ Scond Point lµ c¸c ®iÓm bÊt kú (H×nh 13. 6.14) 

Base point Second point

CEN
QUA

 
    + Base point             + Second point 
       

H×nh 13. 6.14 
a) Chän Base point vµ Second Point bÊt kú b) Truy b¾t ®iÓm 
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2. Chän c¸c ®iÓm Base point vµ Scond Point b»ng c¸ch sö dông c¸c ph−¬ng thøc 
truy b¾t ®iÓm (H×nh 13. 6.14 b) 

3. T¹i dßng nh¾c ‘’Specify second point of displacement or <use first point as 
displacement>’’ ta cã thÓ nhËp to¹ ®é t−¬ng ®èi, to¹ ®é cùc t−¬ng ®èi (H×nh 
13. 6.15) 

Specify base point or displacement, or [Multiple]: Truy b¾t ®iÓm 

Specify second point of displacement or <use first point as 

displacement>:@60,0↵ (hoÆc @60<0) 
4. T¹i dßng nh¾c ‘’Specify base point or displacement, or [Multiple]:’’ ta cã thÓ 

nhËp kho¶ng dêi (H×nh 13. 6.16) 

Specify base point or displacement, or [Multiple]:60,0 (hoÆc 60<0) 

Specify second point of displacement or <use first point as displacement>:↵ 

60<45

60<0

60,0
60<0

 

 
 

H×nh 13. 6.16. Sao chÐp h×nh víi kho¶ng dêi 
     
Lùa chän:  Multiple 

Command: Copy↵ 
Select objects: (Chän ®èi t−îng cÇn sao chÐp) 
 Select objects: (Chän tiÕp c¸c ®èi t−îng hoÆc nhÊn Enter ®Ó kÕt thóc lùa chän) 
Specify base point or displacement, or [Multiple]: M↵ 
Specify base point: Specify second point of displacement or <use first point as  
displacement>: (Chän ®iÓm c¸c ®èi t−îng sÏ copy ®Õn) 

Specify second point of displacement or <use first point as  
displacement>: (Chän ®iÓm c¸c ®èi t−îng sÏ copy ®Õn) 

Specify second point of displacement or <use first point as  
displacement>: ((Chän ®iÓm c¸c ®èi t−îng sÏ copy ®Õn hoÆc nhÊn Enter ®Ó kÕt 

thóc lÖnh) 

a) b) 
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7.  Sao chÐp d·y 

LÖnh: Array 

- Dïng ®Ó sao chÐp c¸c ®èi t−îng ®−îc chän thµnh d·y theo hµng vµ cét 
(Rectangular array) hay s¾p xÕp chung quanh t©m (Polar array). 

- C¸c ®èi t−îng sao chÐp ®−îc c¸ch ®Òu nhau.  
C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Modify → Array 

+ Trªn Modify toolbar → ta chän biÓu t−îng  

+ Command: Array ↵ (HoÆc NhËp ar ↵) 

7.1. Sao chÐp thµnh hµng vµ cét (Rectangular Array) 

Sao chÐp c¸c ghÕ thµnh hµng vµ cét (H×nh 13. 5.17)  

Command: Array↵ 
Select objects: (Chän ®èi t−îng cÇn sao chÐp) 
Select objects: (Chän tiÕp c¸c ®èi t−îng hoÆc nhÊn Enter ®Ó kÕt thóc lùa chän) 
Enter the type of array [Rectangular/Polar] <R>: (NhËp R ®Ó sao chÐp c¸c ®èi 

t−îng theo hµng vµ d·y, nÕu ®¸p P s¾p xÕp c¸c ®èi t−îng chung quanh mét t©m) 
Enter the number of rows (---) <1>: (NhËp sè hµng cÇn sao chÐp) 
Enter the number of columns (|||) <1> : (NhËp sè cét cÇn sao chÐp) 
Enter the distance between rows or specify unit cell (---): (NhËp gi¸ trÞ kho¶ng 

c¸ch gi÷a c¸c hµng gi¸ trÞ nµy cã thÓ ©m hoÆc d−¬ng hoÆc nhËp theo Units cell ®¬n 
vÞ h×nh ch÷ nhËt (H×nh 13. 6.17 b)) 

Specify the distance between columns (|||):(NhËp gi¸ trÞ kho¶ng c¸ch gi÷a c¸c 
hµng gi¸ trÞ nµy cã thÓ ©m hoÆc d−¬ng) 

First point 
of Unitcell

Second point 

 
 
 

  
H×nh 13. 6.17. Sö dông lÖnh Array víi lùc chän Rectangular Array  

K
h
o¶

n
g 
c¸
ch

  

gi
÷
a 
c¸
c 
h
µn

g 

Kho¶ng c¸ch 
gi÷a c¸c cét 
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a) Angle to fill = 360 b) Angle to fill = 250 

Chó ý:  

- Ta cã thÓ dïng « ®¬n vÞ (Unit cell) ®Ó nhËp kho¶ng c¸ch gi÷a c¸c hµng vµ cét. 
(Unit cell) lµ « vu«ng ®¬n vÞ h×nh ch÷ nhËt. Kho¶ng c¸ch theo trôc x lµ kho¶ng c¸ch 
gi÷a c¸c cét, kho¶ng c¸ch theo trôc Y lµ kho¶ng c¸ch gi÷a c¸c hµng 
Enter the distance between rows or specify unit cell (---):Chän ®iÓm thø nhÊt theo 

®¬n vÞ Units cell  

Specify opposite corner: Chän ®iÓm thø 2 cña « ®¬n vÞ 

7.2. Polar Array: 

LÖnh dïng ®Ó t¹o c¸c d·y s¾p xÕp chung quanh mét t©m  

Command: Array↵ 

Select objects: (chän ®èi t−îng cÇn sao chÐp) 

Select objects: NhÊn Enter ®Ó kÕt thóc viÖc lùa chän 

Enter the type of array [Rectangular/Polar] <R>: p 

Specify center point of array:Chän t©m cña d·y 

Enter the number of items in the array:Sè c¸c b¶n cÇn sao chÐp 

Specify the angle to fill (+=ccw, -=cw) <360>:Gãc c¸c ®èi t−îng sÏ ®−îc ®iÒn 

Rotate arrayed objects? [Yes/No] <Y>:Muèn quay c¸c ®èi t−îng sao chÐp hay 
kh«ng? 

          
 

   

H×nh 13.6.17. Sö dông lÖh Array víi lùc chän Polar Array 
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8. Bµi tËp 
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Bµi 7 

 Qu¶n lý ®èi t−îng trong b¶n vÏ 
(Líp- mµu vµ ®−êng nÐt) 

M· bµi:  MH CG1 13 19 

I. Giíi thiÖu 
 
- Bµi häc nµy gióp cho häc sinh biÕt c¸ch hiÖu chØnh ®èi t−îng b»ng c¸c ph−¬ng 

thøc lùa chän ®èi t−îng trong mét sè tr−êng hîp ta kh«ng thÓ vÏ ®èi t−îng b»ng 
c¸ch nhËp to¹ ®é ®−îc. 

II. Môc tiªu thùc hiÖn 
 
- T¹o ®−îc c¸c líp vÏ.  

- G¸n ®−îc c¸c mµu, c¸c lo¹i ®−êng nÐt cho c¸c líp t−¬ng øng. 
 

III. Néi dung chÝnh: 
 
1. T¹o vµ hiÖu chØnh líp 

2. T¹o líp míi 

3. G¸n vµ thay ®æi mµu cho líp 

4. G¸n d¹ng ®−êng cho líp 

5. G¸n chiÒu réng nÐt in (lineweight) 

6. G¸n líp hiÖn hµnh (current) 

7. T¾t më líp (on/off) 

8. §ãng vµ lµm tan b¨ng cña mét líp cho tÊt c¶ khung nh×n (Freeze/thaw) 

9. Kho¸ vµ më kho¸ cho líp (lock/unlock) 
  

IV. C¸c h×nh thøc häc tËp: 
  
- Häc trªn líp vÒ c¸c c¸ch tạo lớp vµ hiÖu chØnh c¸c líp. 

- G¸n c¸c thuéc tÝnh cña líp 
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1. T¹o vµ hiÖu chØnh líp 

-  LÖnh: Layer 

-  C¸ch vµo lÖnh: 3 c¸ch 

+ Menu → Format → Layer 

+ Vµo biÓu t−îng   

+ Command: Layer↵ 

- Khi thùc hiÖn lÖnh layer trªn mµn 

 h×nh xuÊt hiÖn hép héi tho¹i  
          
                          Layer Properties manager - H×nh 13. 7.1 

2. T¹o líp míi  

- §Ó t¹o líp míi (Layer míi) ta tiÕn 
hµnh nh− sau 

+ NhÊp nót New hép tho¹i (H×nh 
13. 7.1) d−íi layer 0 xuÊt hiÖn layer 1 
(H×nh 13.7.2) 

+ T¹i cét name ta nhËp tªn líp vµo « 
so¹n th¶o. (Tªn líp kh«ng ®−îc dµi qu¸ 
255 ký tù. Ký tù cã thÓ lµ sè, ch÷ hoÆc - 
_... kh«ng ®−îc cã kho¶ng trèng. Nªn 
®Æt tªn líp dÔ nhí) 

+ KÕt thóc viÖc t¹o líp ta chän OK 

3.  G¸n vµ thay ®æi mµu cho líp 

- G¸n vµ thay ®æi mµu cho líp ta thùc 
hiÖn theo tr×nh tù sau: 

+ Chän líp cÇn g¸n vµ thay ®æi mµu 
b»ng c¸ch chän tªn líp ®ã 

+ NhÊn vµo « mµu cña líp t¹i cét 
color, khi ®ã trªn mµn h×nh xuÊt hiÖn hép 
tho¹i lùa chän « mµu, ta chän mét mµu 
mong muèn trªn b¶ng mµu (H×nh 13. 7.3). 

+ T¹i môc color ta cã thÓ nhËp c¸c sè 
cho c¸c mµu, vÝ dô nh−: 1- red (®á), 2- 
Yellow (vµng)... 

H×nh 13.7.2 

H×nh 13.7.3 
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4. G¸n d¹ng ®−êng cho líp 

- G¸n d¹ng ®−êng cho líp ta 
thùc hiÖn theo tr×nh tù sau: 

+ Chän líp cÇn g¸n vµ thay ®æi 
®−êng b»ng c¸ch chän tªn líp ®ã 

+ NhÊn vµo « t¹o ®−êng cña líp 
t¹i cét Linetype, khi ®ã trªn mµn 
h×nh xuÊt hiÖn hép tho¹i lùa chän 
®−êng Select linetype (H×nh  13.7.4)
  

+ Ta  chän vµ «  Load   ®Ó t¶i c¸c ®−êng tõ th− viÖn CAD vµo hép tho¹i khi ®ã 

trªn mµn h×nh xuÊt hiÖn hép tho¹i (H×nh 13. 7.5)  

 
H×nh 13.7.5 

- Ta chän mét lo¹i ®−êng mong 
muèn trong hép tho¹i, Ên nót OK ®Ó 
kÕt thóc lùc chän ®−êng. Khi ®ã 
trong hép Select linetype (H×nh 13. 
7.4). cã thªm mét ®−êng nh− (H×nh 
13. 7.6) 

 

 

 

 

H×nh 13.7.4 

H×nh 13.7.6 
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5. G¸n chiÒu réng nÐt vÏ 
(lineweight) 

- G¸n d¹ng ®−êng cho líp ta thùc hiÖn 
theo tr×nh tù sau: 

+ Chän líp cÇn thay ®æi nÐt in b»ng c¸ch 
chän tªn líp ®ã 

+ NhÊn vµo « t¹o nÐt in cña líp t¹i cét 
Lineweight, khi ®ã trªn mµn h×nh xuÊt hiÖn 
hép tho¹i lùa chän nÐt in lineweight (H×nh 
13.7.7). 

+ Trªn thanh Scroll bar ta kÐo ®Ó chän nÐt 
vÏ mong muèn, sau ®ã chän OK 

6. G¸n líp hiÖn hµnh (current) 

- Ta chän líp  

- Chän nót current, t¹i hép tho¹i current layer hiÖn tªn líp võa chän 

7. T¾t më líp (on/off) 

- §Ó t¾t më líp ta nhÊp vµo biÓu t−îng tr¹ng th¸i ON/OFF (H×nh 13. 7.2).  

- Khi mét líp ®−îc t¾t th× c¸c ®èi t−îng n»m trªn líp ®ã kh«ng hiÖn trªn mµn 
h×nh.  

- C¸c ®èi t−îng vÉn bÞ xo¸ nÕu t¹i dßng nh¾c “select object” cña lÖnh Erase ta 
chän All 

8. §ãng vµ lµm tan b¨ng cña mét líp cho tÊt c¶ khung nh×n 
(Freeze/thaw) 

- §Ó ®ãng b¨ng (FREEZE) vµ lµm tan b¨ng (THAW) líp trªn tÊt c¶ khung nh×n 
(viewports) ta nhÊp vµo biÓu t−îng tr¹ng th¸i (Freeze/thaw) (H×nh 13.7.2). 

- C¸c ®èi t−îng cña líp ®ãng b¨ng kh«ng xuÊt hiÖn trªn mµn h×nh vµ ta kh«ng 
thÓ hiÖu chØnh c¸c ®èi t−îng nµy (ngay c¶ lùa chän All). 

- Trong qu¸ tr×nh t¸i hiÖn b¶n vÏ b»ng lÖnh Regen, Zoom: c¸c ®èi t−îng cña líp 
®ãng b¨ng bÞ l¬ ®i gióp cho qu¸ tr×nh t¸i hiÖn ®−îc nhanh h¬n. 

- Líp hiÖn hµnh kh«ng thÓ ®ãng b¨ng.    

9. Kho¸ vµ më kho¸ cho líp (lock/unlock) 

- §Ó kho¸ vµ më kho¸ cho líp ta nhÊp vµo biÓu t−îng tr¹ng th¸i (lock/unlock) 
(H×nh 13. 6.3)  

H×nh 13.7.4

H×nh 13.7.7 
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- §èi t−îng bÞ kho¸ kh«ng hiÖu chØnh ®−îc mµ ®èi t−îng vÉn nh×n thÊy trªn mµn 
h×nh vµ cã thÓ in chóng ra ®−îc. 

10. HiÖu chØnh líp 

- Thay ®æi c¸c thuéc tÝnh cña líp tõ hép tho¹i Layer vµo cÇn hiÖu chØnh thay ®æi 
c¸c thuéc tÝnh cña líp 

- Chän c¸c ®èi t−îng, chän líp phï hîp 
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Bµi 8 

Ghi vµ hiÖu chØnh v¨n b¶n 

M· bµi:  MH CG1 13 21 

I. Giíi thiÖu:   

- Ghi vµ hiÖu chØnh ®−îc c¸c v¨n b¶n ghi chó trªn b¶n vÏ vµ c¸c yªu cÇu kü thuËt 
trªn b¶n vÏ. 

II. Môc tiªu thùc hiÖn.  

- Ghi vµ hiÖu chØnh v¨n b¶n vµ c¸c yªu cÇu kü thuËt trªn b¶n vÏ 

III. Néi dung chÝnh: 

1. T¹o kiÓu ch÷ (text style).  

2 .Ph−¬ng ph¸p nhËp dÊu tiÕng viÖt theo font VNI font. 

3. NhËp ®o¹n v¨n b¶n vµo b¶n vÏ (lÖnh Mtext). 

4. HiÖu chØnh v¨n b¶n Mtext b»ng lÖnh Mtprop. 

IV.  C¸c h×nh thøc häc tËp: 

- T¹o kiÓu ch÷. 

- Ph−¬ng ph¸p t¹o tiÕng viÖt trªn b¶n vÏ. 

- C¸ch nhËp ®o¹n v¨n b¶n trªn b¶n vÏ. 

- Gi¸o viªn h−íng dÉn c¸ch t¹o kiÓu ch÷, c¸ch gâ tiÕng viÖt vµ t¹o v¨n b¶n trªn 
b¶n vÏ.  

1. §Þnh kiÓu ch÷ cho b¶n vÏ (text style)  

- LÖnh: Style 

- Trªn thanh c«ng cô Menu ta chän Format vµ chän Text Style trªn mµn h×nh 
xuÊt hiÖn hép tho¹i (H×nh 13. 8.1) 
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H×nh 13. 8.1 

   
Chän nót New.. sÏ xuÊt hiÖn hép 

tho¹i New text Style (H×nh 13. 8.2) trong 
« Style Name ta nhËp tªn kiÓu ch÷ míi 
(vÝ dô: Viet) vµ nhÊp nót OK 

Chän font ch÷:  

T¹i môc font name (H×nh 13. 8.1) ta 
chän font VNI-Times 

ChiÒu cao cña ch÷ ta nhËp vµo « Hieght, muèn ch÷ nghiªng ta nhËp gãc nghiªng 
vµo « Oblique Angle 

2. Ph−¬ng ph¸p nhËp dÊu tiÕng viÖt theo font VNI font 

Trong lÖnh Mtext, Text ta nhËp dÊu tiÕng viÖt t−¬ng tù nh− VNI font trong c¸c 
phÇn mÒm v¨n b¶n kh¸c, ta nhËp dÊu tiÕng viÖt nh− sau 

  
PhÝm DÊu VÝ dô M« t¶ KÕt qu¶ 

1 DÊu s¾c ca1c SÏ xuÊt hiÖn C¸c 

2 DÊu huyÒn Ca2 SÏ xuÊt hiÖn Cµ 
3 DÊu hái Ca3 SÏ xuÊt hiÖn C¶ 

4 DÊu ng· Ve4 SÏ xuÊt hiÖn VÏ 

5 DÊu nÆng Cho5n  SÏ xuÊt hiÖn Chän 
6 DÊu mò ^ Da6n  SÏ xuÊt hiÖn D©n 

7 DÊu hái ¬ Tu7 SÏ xuÊt hiÖn T− 

8 DÊu ¸ A8n SÏ xuÊt hiÖn ¨n 

9 Ch÷ §  D9o SÏ xuÊt hiÖn §o 

 
H×nh 13. 8.2 
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C¸c ký tù ®Æc biÖt 

 Ký hiÖu    VÝ dô    kÕt qu¶ 

 %%C (§−êng kÝnh)   %%C40   φ40 

 §é     30%%d   300 

 DÊu ±     %%p30   ± 30 

3. NhËp ®o¹n v¨n b¶n vµo b¶n vÏ (lÖnh Mtext) 

LÖnh Mtext  

Lệnh cho phÐp t¹o mét ®o¹n v¨n b¶n ®−îc giíi h¹n bëi ®−îc giíi h¹n bëi ®−êng 

biªn lµ khung h×nh ch÷ nhËt. §o¹n v¨n b¶n lµ mét ®èi t−îng cña AutoCAD. 

Command: Mtext ↵ 

Current text style:  "viet"  Text height:  2.5 

Specify first corner: (§iÓm gèc thø nhÊt ®o¹n v¨n b¶n) 

Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]: 
(§iÓm gèc thø hai ®o¹n v¨n b¶n) 

Sau ®ã trªn mµn h×nh xuÊt hiÖn hép tho¹i Multiline Text Editor  (H×nh 13. 8.3) 
trªn hép tho¹i nµy ta nhËp v¨n b¶n nh− c¸c phÇn mÒm kh¸c. 

    
VÞ trÝ ghi v¨n b¶n      Font       ChiÒu cao font       Huû lÖnh ChÌn ký tù 

 

 

 

 

 

 

 

H×nh 13. 8.3 
      

4. HiÖu chØnh v¨n b¶n Mtext b»ng lÖnh Mtprop 
     
LÖnh: Mtprop  sö dông ®Ó thay ®æi c¸c tÝnh chÊt cña Mtext. 

Command: Mtprop↵ 

Select an MTEXT object: (Chän ®o¹n v¨n b¶n cÇn hiÖu chØnh) 
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Sau ®ã trªn mµn h×nh xuÊt hiÖn héi tho¹i (H×nh 13. 8.4) 
    

 
H×nh 13. 8.4 
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Bµi 9 

H×nh c¾t vµ mÆt c¾t - vÏ ký hiÖu vËt liÖu 

M· bµi: MH CG1 13 22 

I. Giíi thiÖu: 

Bµi häc nµy gióp cho häc sinh biÕt c¸ch chän lo¹i mÆt c¾t, chän vïng vÏ mÆt c¾t. 

HiÖu chØnh ®−îc mÆt c¾t.  

II. Môc tiªu thùc hiÖn: 

Chän ®−îc lo¹i mÆt c¾t phï hîp víi tõng vËt liÖu. 

X¸c ®Þnh ®−îc vïng vÏ mÆt c¾t vµ hiÖu chØnh ®−îc tû lÖ mÆt c¾t phï hîp víi 
b¶n vÏ. 

III. Néi dung chÝnh: 

1. VÏ mÆt c¾t b»ng lÖnh Bhatch 

2. Trang Quick 

3. X¸c ®Þnh ®−êng biªn mÆt c¾t (Boundary) 

4. HiÖu chØnh mÆt c¾t (Hatchedit) 

5. Bµi tËp 

IV. C¸c h×nh thøc häc tËp: 

- C¸ch chän mÆt c¾t, x¸c ®Þnh mÆt c¾t. 

- C¸ch chän c¸c d¹ng vÏ mÆt c¾t. 

- C¸ch hiÖu chØnh mÆt c¾t. 

- Gi¸o viªn tr×nh bµy ph−¬ng ph¸p chän mÆt c¾t, lùa chän vïng vÏ mÆt c¾t, vµ 
c¸ch hiÖu chØnh mÆt c¾t. Gi¸o viªn dïng m¸y chiÕu Projector chiÕu c¸ch lµm bµi tËp 
mÉu ®Ó häc sinh theo dâi. 

1. VÏ mÆt c¾t b»ng lÖnh Bhatch 

LÖnh: Bhatch dïng ®Ó vÏ ký hiÖu vËt liÖu trªn mÆt c¾t trong mét ®−êng biªn kÝn 

C¸ch vµo lÖnh: 
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- Trªn Menu ta chän Draw råi 
chän Hatch 

- Trªn thanh c«ng cô ta chän 
biÓu t−îng  

- Command: Bhatch↵ 

- Khi thùc hiÖn lÖnh Bhatch 
trªn mµn h×nh xuÊt hiÖn hép héi 
tho¹i Boundary Hatch (H×nh 13. 
9.1). Hép tho¹i nµy cã hai trang lµ 
Quick vµ Advanced 

1.1. Trang Quick 

1.1.1. Lùa chän mÉu mÆt c¾t 
(pattern palette) 

Lùa chän mÆt c¾t trong « pattern (H×nh 13. 9.1) khi ®ã trªn mµn h×nh xuÊt hiÖn 
hép tho¹i (H×nh 13. 9.2). Ta chän mét mÆt c¾t theo mong muèn. Kh¼ng ®Þnh lùa 
chän b»ng nót OK. 

 
H×nh 13. 9.2 

 
H×nh 13.9.1 
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1.1.2 G¸n c¸c thuéc tÝnh cho mÉu mÆt c¾t (Pattern Propeties) 

Scale. 

Gi¸ trÞ nhËp vµo « so¹n th¶o 
nµy lµ gi¸ trÞ hÖ sè tØ lÖ cho mÆt 
c¾t ®ang chän. Th«ng th−êng hÖ 
sè tØ lÖ nµy phô thuéc vµo giíi h¹n 
b¶n vÏ.  

Chó ý: 

NÕu giíi h¹n b¶n vÏ 420x297 
ta nªn chän gi¸ trÞ nµy lµ 1 ngo¹i 
trõ nh÷ng mÉu mÆt c¾t cã ký hiÖu 
b¾t ®Çu bëi hai tõ AR- th× tØ lÖ 
chän lµ 0.04 - 0.08. 

Angle 

Gi¸ trÞ nhËp vµo « so¹n th¶o 
nµy ®Þnh ®é nghiªng cña c¸c ®−êng c¾t so víi mÉu chän. Gi¸ trÞ mÆc ®Þnh lµ 0 

1.2 Trang Advanced 

Khi chän trang Advanced th× hép tho¹i 

Boundary Hatch cã h×nh d¹ng nh−  

T¹i môc Island Detection Style 

Chän c¸c kiÓu vÏ mÆt c¾t cã 3 kiÓu: Normal, Outer vµ Ignore. (H×nh 13. 9.3) 
    
 

 

 

 
        
      a) Normal                                           b) Outer                                   c) Ignore. 

H×nh 13.9.3 
   

2. X¸c ®Þnh ®−êng biªn mÆt c¾t (Boundary) 

  X¸c ®Þnh ®−êng biªn kÝn b»ng c¸ch chän mét ®iÓm n»m trong 

vïng vÏ mÆt c¾t. NÕu ®−êng biªn kÝn th× AutoCAD t¹o mét ®−êng biªn kÝn lµ mét 
Spline.  

 
H×nh 13. 13.9.2 
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Khi chän vµo môc Pick points t¹i dßng nh¾c xuÊt hiÖn dßng yªu cÇu:  

Select internal point: (Chän mét ®iÓm bªn trong ®−êng biªn kÝn) 

Select internal point: (TiÕp tôc chän mét ®iÓm bªn trong ®−êng biªn kÝn hay 

nhÊn Enter ®Ó kÕt thóc lÖnh) 

  Chän ®−êng biªn b»ng c¸ch chän c¸c ®èi t−îng 

3. HiÖu chØnh mÆt c¾t (Hatchedit) 

C¸ch vµo lÖnh: 

+ Command: Hatchedit↵ 

+ Chọn mặt cắt, bÊm phÝm ph¶i chuét chän Hatchedit.. 

Select associative hatch object: (Chän mÆt c¾t cÇn hiÖu chØnh) 

Khi ®ã trªn mµn h×nh xuÊt hiÖn hép héi tho¹i Hatch edit (H×nh 13. 9.4) t−¬ng 
tù hép héi tho¹i Boundary Hatch. Ta nhËp l¹ c¸c th«ng sè cña mÆt c¾t trong hép 
tho¹i.  

 
H×nh 13. 13.9.4 

4. Bµi tËp 

1) Thùc hiÖn c¸c bµi tËp 
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H×nh 13. 9.5 

2) Thùc hiÖn c¸c bµi tËp 
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            c)        d) 

H×nh 13. 9.6 
   
3. Thực hiện bản vẽ H×nh 13.10.7 

 
   

H×nh 13.9.7 



 116 

4) Thực hiện bản vẽ H×nh 13.9.8 
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Bµi 10 

Ghi vµ hiÖu chØnh kÝch th−íc 

M· bµi:  MH CG1 13 22 

I. Giíi thiÖu:   

Bµi häc nµy gióp cho häc sinh biÕt c¸ch ghi vµ hiÖu chØnh kÝch th−íc, ghi ký 
hiÖu bÒ mÆt. 

II. Môc tiªu thùc hiÖn 

- Ghi kÝch th−íc vµ hiÖu chØnh kÝch th−íc.  

- Ghi vµ hiÖu chØnh ký hiÖu bÒ mÆt. 

Néi dung chÝnh: 

1. C¸c thµnh phÇn kÝch th−íc 

2. Ghi kÝch th−íc th¼ng 

3. Ghi kÝch th−íc cung vµ ®−êng trßn 

4. Ghi To¹ ®é ®iÓm 

5. Bµi tËp 

IV. C¸c h×nh thøc häc tËp: 

- C¸c kh¸i niÖm vÒ kÝch th−íc. 

- C¸c c¸ch ghi cña tõng lo¹i kÝch th−íc. 

- Gi¸o viªn tr×nh bµy c¸c c¸ch ghi kÝch th−íc, lµm vÝ dô mÈu tr×nh bµy tr×nh tù 
trªn m¸y chiÕu Projector ®Ó häc sinh theo dâi.  

1. C¸c thµnh phÇn kÝch th−íc 

KÝch th−íc ®−îc ghi bao gåm c¸c thµnh phÇn chñ yÕu sau: 
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(Extension line)(Exten line) (Dimension text)(Dimension line)
 

 

H×nh 13.10.1. §−êng kÝch th−íc (Dimension line) 

2. Ghi kÝch th−íc th¼ng 

2.1. LÖnh Dimlinear 

C¸c c¸ch nhËp lÖnh : 

+ Menu → Dimension → Linear 

+ Trªn thanh Standard menu → ta chän biÓu t−îng  

+ T¹i dßng Command: Ta nhËp Dimlinear↵ hoÆc Dimlin ↵ 

1. Chän hai ®iÓm gèc hai ®−êng giãng 

Command: Dimlinear↵ 

Command: DIMLINEAR↵ 

Specify first extension line origin or <select object>:  Chän ®iÓm gãc ®−êng 
giãng thø nhÊt 

Specify second extension line origin: Chän ®iÓm gèc ®−êng giãng thø hai 

Specify dimension line location or 
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: Chän mét ®iÓm ®Ó ®Þnh vÞ trÝ ®−êng 
kÝch th−íc hoÆc nhËp theo to¹ ®é t−¬ng ®èi) 

Dimension text = 120 ch÷ sè kÝch th−íc. 

2. Ph−¬ng ph¸p chän ®èi t−îng 

Command: DIMLINEAR↵ 

Specify first extension line origin or <select object>: ↵ 

Select object to dimension: Chän ®èi t−îng cÇn ghi kÝch th−íc 

   §−êng giãng §Çu mòi tªn 

(Arrowhead) 

   §−êng kÝch th−íc    Ch÷ sè kÝch th−íc 
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Specify dimension line location or 
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: Chän mét ®iÓm ®Ó ®Þnh vÞ trÝ ®−êng 
kÝch th−íc hoÆc nhËp theo to¹ ®é t−¬ng ®èi) 

Dimension text = 120 ch÷ sè kÝch th−íc.  

3. C¸c lùa chän kh¸c: 

Text: Dïng ®Ó nhËp ch÷ sè kÝch th−íc hoÆc c¸c ký tù tr−íc vµ sau ch÷ sè kÝch 
th−íc 

Command: _dimlinear 

Specify first extension line origin or <select object>: 

Specify second extension line origin: 

Specify dimension line location or 

[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: t↵ 

Enter dimension text <100>: H7f6%%C100↵ 

Ta ®−îc nh− (H×nh 13. 9.2) 

Angle: §Þnh gãc nghiªng cho dßng ch÷ sè kÝch th−íc so víi ®−êng chuÈn 

Specify dimension line location or 

[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: a↵ 

Specify angle of dimension text: ( NhËp gi¸ trÞ gãc nghiªng ch÷ sè kÝch th−íc) 
H×nh 13.9.3 

 
      a) Angle = 30                                         b) Angle = 90 

H×nh 9.3 §Þnh gãc nghiªng cho ch÷ sè kÝch th−íc. 
 

2.2. LÖnh Dimaligned 

- LÖnh nµy dßng kÝch th−íc ®−îc ghi sÏ song song víi ®o¹n th¼ng nèi hai ®iÓm 
®−êng giãng. 

C¸c c¸ch nhËp lÖnh : 

+ Menu → Dimension → Aligned 

H×nh 13. 9.2 
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+ Trªn thanh Standard menu → ta chän biÓu t−îng  

+ T¹i dßng Command: Ta nhËp Dimaligned ↵ hoÆc Dimali↵ 

Command: Dimaligned↵ 

Specify first extension line origin or 
<select object>:  Chän ®iÓm gãc ®−êng giãng 
thø nhÊt hoÆc Enter ®Ó chän ®èi t−îng. 

Specify second extension line origin: Chän 
®iÓm gãc ®−êng giãng thø hai 

Specify dimension line location or 
[Mtext/Text/Angle]: Chän mét ®iÓm ®Ó ®Þnh vÞ 
trÝ ®−êng kÝch th−íc hoÆc nhËp theo to¹ ®é 
t−¬ng ®èi. H×nh 9.4 

3. Ghi kÝch th−íc cung vµ ®−êng trßn 

3.1. Ghi kÝch th−íc b¸n kÝnh 

+ Menu → Dimension → Radius 

+ Trªn Standard menu → ta chän biÓu t−îng  

+ Command: Ta nhËp Dimradius ↵  

Command: Dimradius↵ 

Select arc or circle: Chän cung hoÆc ®−êng trßn. 

Specify dimension line location or [Mtext/Text/Angle]: X¸c ®Þnh vÞ trÝ kÝch 
th−íc. 

H×nh 9.5   

 
H×nh 9.5. C¸c d¹ng ghi kÝch th−íc b¸n kÝnh 

3.2. Ghi kÝch th−íc ®−êng kÝnh   

+  Menu → Dimension → Diameter 

+ Trªn Dimension toolbar → chän biÓu t−îng  

+ T¹i dßng Command: Ta nhËp Dimdiameter ↵  

 
H×nh 9.4 
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P1

P3

P2

60
°

Command: Dimdiameter↵ 

Select arc or circle: Chän cung hoÆc ®−êng trßn. 

Specify dimension line location or [Mtext/Text/Angle]: X¸c ®Þnh vÞ trÝ kÝch 
th−íc. 

H×nh 9.6 

 
       a)                                   b)                                     c)                                   d)       

H×nh 13. 10.6 
   
H×nh a, c) ta chän chÕ ®é ISO Standard víi biÕn Dimtofl = on 

H×nh b) ta chän chÕ ®é ISO Standard víi biÕn Dimtofl = on víi trang Style môc 
Fit  ta chän môc Text 

H×nh d) ta chän chÕ ®é ISO Standard víi biÕn Dimtofl = off 

3.3. Ghi kÝch th−íc Gãc  

+ Menu → Dimension → Dimangular 

+ Trªn thanh Standard menu → ta chän biÓu t−îng  

+ T¹i dßng Command: Ta nhËp Dimangular ↵ hoÆc Dimang↵ 

1) Ghi kÝch th−íc gãc gi÷a hai ®o¹n th¼ng 

Ghi kÝch th−íc gãc gi÷a hai ®o¹n th¼ng P1P2 vµ P3P4 H×nh 9.7 

     

P2

P1P3

60°

                           
    
           (H×nh 13. 9.7                                                              (H×nh 13. 9.8 

Command: Dimangular↵ 

Select arc, circle, line, or <specify vertex>: Chän ®o¹n th¼ng thø nhÊt P1P2 
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Select second line: Chän ®o¹n th¼ng thø hai P1P3 

Specify dimension arc line location or [Mtext/Text/Angle]: Chän vÞ trÝ ®−êng  

kÝch th−íc 

2) Ghi kÝch th−íc gãc qua ba ®iÓm 

Command: Dimangular↵ 

Select arc, circle, line, or <specify vertex>: ↵ 

Specify angle vertex: Chän ®iÓm ®Ønh cña gãc P1 

Specify first angle endpoint: X¸c ®Þnh ®iÓm cuèi c¹nh thø nhÊt P2 

Specify second angle endpoint: X¸c ®Þnh ®iÓm cuèi c¹nh thø hai P3 

Specify dimension arc line location or [Mtext/Text/Angle]: Chän vÞ trÝ ®−êng 
kÝch th−íc. (H×nh 13. 9.7) 

3) Ghi kÝch th−íc gãc ë t©m cung trßn 

Command: _dimangular 

Select arc, circle, line, or <specify vertex>: Chän cung trßn h×nh 9.8 

Specify dimension arc line location or [Mtext/Text/Angle]: Chän vÞ trÝ ®−êng  

kÝch th−íc 

4 Ghi To¹ ®é ®iÓm  

+ Menu → Dimension → Dimordinate 

+ Trªn Dimension toolbar→ ta chän biÓu t−îng  

+ Command: Dimordinate ↵, Dimord↵ hoÆc Dor↵ 

- LÖnh Dimordinate dïng ®Ó ghi to¹ ®é mét ®iÓm. (H×nh 13. 9.9) 

0 3
5

1
6
5

2
0
0

1
0
0

0

40

110

140

 
H×nh 9.9 
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Command: Dimordinate↵ 

Specify feature location: Chän ®iÓm dïng ghi kÝch th−íc 

Specify leader endpoint or [Xdatum/Ydatum/Mtext/Text/Angle]: Chän vÞ trÝ 
®−êng kÝch th−íc 

4.1. Ghi chuçi kÝch th−íc 

4.1.1  Chuçi kÝch th−íc song song (LÖnh Dimbaseline) 

+ Menu → Dimension → Baseline 

+ Trªn Dimension toolbar → chän biÓu t−îng  

+ Command: Dimbaseline ↵, Dimbase↵ hoÆc bba↵ 

15

30

50

75

90

120

135

D
im

d
li

 
 H×nh 9.10 

T¹o ®−êng kÝch th−íc gèc b»ng lÖnh Dimlinear víi kÝch th−íc 15 

Command: Dimbaseline↵ 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 30 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 50 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 75 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 90 
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Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 120 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 135 

Specify a second extension line origin or [Undo/Select] <Select>:Enter ®Ó kÕt 
thóc ghi chuçi kÝch th−íc. Ta ®−îc nh− h×nh 9.10 

4.1.2. Ghi chuçi kÝch th−íc nèi tiÕp (lÖnh Dimcontinue) 

+ Menu → Dimension → Continue 

+ Trªn Dimension toolbar → chän biÓu t−îng  

+ Command: Dimcontinue ↵ hoÆc Dimcont↵  

Command: Dimcontinue↵ 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 25 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 15 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 30 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Dimension text = 15 

Specify a second extension line origin or [Undo/Select] <Select>: Chän gèc 
®−êng giãng thø hai 

Select continued dimension: Enter ®Ó kÕt thóc lÖnh ghi kÝch th−íc kÕt qu¶ ta 
®−îc nh− h×nh 9.11 

50 25 15 30 15

 
H×nh 10.11 Ghi chuçi kÝch th−íc liªn tôc 
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H×nh 9.12 

4.1.3. Ghi chuçi kÝch th−íc gãc nèi tiÕp 

B−íc 1: Ghi kÝch th−íc víi lÖnh Dimangular 

Command: Dimangular↵ 

Select arc, circle, line, or <specify vertex>: Chän ®iÓm ®Ønh cña gãc 

Select second line: Chän ®iÓm ®Ønh thø hai cña gãc 

Specify dimension arc line location or [Mtext/Text/Angle]: Chän vÞ trÝ ®−êng 
cung kÝch th−íc 

Dimension text = 15 

B−íc 2: Ghi kÝch th−íc liªn tôc víi lÖnh Dimcontinue 

Command: Dimcontinue↵ 

Specify a second extension line origin or [Undo/Select] <Select>: Chän P3 

Dimension text = 30 

Specify a second extension line origin or [Undo/Select] <Select>: Chän P4 

Dimension text = 60 

Specify a second extension line origin or [Undo/Select] <Select>: Chän P5 

Dimension text = 30 

Specify a second extension line origin or 
[Undo/Select] <Select>: Chän P6    

pecify a second extension line Dimension 
text = 60 

origin or [Undo/Select] <Select>: Chän P7 

Dimension text = 15 

Specify a second extension line origin or 
[Undo/Select] <Select>: Chän P8 

Dimension text = 75 

Specify a second extension line origin or 
[Undo/Select] <Select>: ↵ KÕt thóc lÖnh 

5. Bµi tËp 

1) VÏ h×nh ghi ®Çy ®ñ kÝch th−íc 
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Tæ chøc b¶n th¶o vµ chÞu tr¸ch nhiÖm néi dung: 

Tæng côc D¹y nghÒ 
Tr−êng Cao ®¼ng c«ng nghiÖp HuÕ 

 
Biªn tËp vµ hiÖu ®Ýnh: 

NguyÔn V¨n TÊn 
 

Tr×nh bµy b×a: 

Thanh HuyÒn 
 

 
                   

 

 

Gi¸o tr×nh VÏ Autocad 2000 2D 

MX sè: M§ CG 1 13 
 

In: 350 b¶n, khæ 19 x 27cm. T¹i C«ng ty Cæ phÇn in Diªn Hång 187B, 
Gi¶ng Vâ - Hµ Néi. Sè in: 516. Sè xuÊt b¶n: 114-2008/CXB/03-12/L§-XH. 

In xong vµ nép l−u chiÓu th¸ng 5 n¨m 2008. 


